
Add or change an AutoShape
Microsoft Draw comes with a set of ready-made shapes called AutoShapes. These shapes can be resized, 
rotated, flipped, colored, and combined with other shapes to make more complex shapes. Many have an 
adjustment handle you can use to change the most prominent feature of a shape ¾ for example, the size of the 
point on an arrow. The AutoShapes menu on the Drawing toolbar contains several categories of shapes, 
including lines, connectors, basic shapes, block arrows, flowchart elements, stars and banners, and callouts.

To add text to an AutoShape, just click the shape and start typing. The text becomes part of the shape ¾ if you 
move the shape, the text moves with it.

What do you want to do?

            Add a circle, square, or other AutoShape  
            Change one AutoShape into another  



Add a circle, square, or other AutoShape
1 On the Drawing toolbar, click AutoShapes, point to a category, and then click the shape you want.
2 To insert the shape at its default size, click the page.

To insert a different size, drag the shape to the size you want.
To define the shape within a perfect square, hold down SHIFT while you drag the shape.

Tips

· To draw a circle or square, click Oval        or Rectangle    

    on the Drawing toolbar, and then click the page.
· To add color, change borders, rotate, or add shadow or 3-D effects to an AutoShape, select the object, and 
then use the tools on the Drawing toolbar. 



Change one AutoShape to another
1 Select the AutoShape you want to change.
2 On the Drawing toolbar, click Draw, point to Change AutoShape, point to a category, and then click the 

shape you want.





Replace a clip art image
1 Double-click the image you want to replace.
2 Double-click a new image.

Note      If you've converted the image to a drawing object, you must delete it and then click Insert Clip Art      
to select a new image. You'll know you've converted the image if the Clip Gallery doesn't appear when you 
double-click the image.



Insert clip art or a picture from the Clip Gallery

1 Click Insert Clip Art    , and then click the Clip Art or Pictures tab.
2 Click the category you want, and then double-click the image.



Ungroup and modify clip art
1 Select the clip art you want to modify. 

2 Click Ungroup    .
If the image is a bitmap, it can’t be ungrouped.

3 To modify an individual object within the image, continue to select and ungroup objects until the one you want 
becomes available.

4 Use the tools on the Drawing toolbar to modify the object.
For example, you can rearrange parts of the image, combine two or more images, or change the fill and line 
colors.

5 To restore the individual objects to one image, select all objects and groups that make up the image, and then 

click Group    .



About the Clip Gallery
The Clip Gallery includes a wide variety of clip art that makes it easy for you to dress up drawings with 
professionally designed images. You'll find everything from maps to people, and from buildings to scenic 
backgrounds.

To add clip art to a drawing, click Insert Clip Art    , and then click the Clip Art tab. You can browse through 
the collection of images and select the one you want.

After you place clip art on a page, you can change its size, location, and appearance. You can also use the Ungroup 
button to convert the image to groups of drawing objects and then work with the objects just as you work with any 
other drawn object ¾ for example, you can change fill and line colors, rearrange parts, and even combine two or 
more images.

The Clip Gallery includes a handy Find feature to help you locate the right images. It also includes its own Help 
system, where you'll find such information as how to add your own pictures to the gallery, how to keep it up to 
date, and how you can personalize it to suit your own needs. To use the Find feature or to get Help, click Find or 
Help on the Clip Art tab.





Click the color you want, or enter the values for the color in the Hue, Sat, Lum, Red, Green, and Blue boxes. 
You can drag the slider to adjust the luminosity of the currently selected color.



Hue is the color itself. Enter a number from 0 to 255 in the Hue box, or drag the cross-hair horizontally in the 
Color box.



Saturation is the intensity of the color. The higher the number, the more intense the color. Enter a number from 0 
to 255 in the Sat box, or drag the cross-hair vertically in the Color box.



Luminance is the brightness of the color, or the amount of black or white added to the color. The larger the 
number, the lighter the color. Enter a number from 0 to 255 in the Lum box, or drag the slider on the vertical color
bar.



Enter a number from 0 to 255 to adjust the amount of red in the color. The larger the number, the more red the 
color contains.



Enter a number from 0 to 255 to adjust the amount of green in the color. The larger the number, the more green 
the color contains.



Enter a number from 0 to 255 to adjust the amount of blue in the color. The larger the number, the more blue the 
color contains.



Click the color you want, or click the Custom tab and mix your own color. 



Makes the selected color partially transparent. Clear this check box to make the selected color completely 
opaque. This effect of this option is not displayed in the New and Current sample box.



The New color is the one you selected in this dialog box — click OK to apply the new color to the selected object.
The Current color is the existing color of the object — click Cancel to retain the current color.





Copy or duplicate objects
You can quickly duplicate an object. Or you can make lots of duplicates and then use them to create arrays and 
sweeps.

What do you want to do?

            Make a duplicate of an object  
            Make multiple duplicates and space them evenly  
            Create a mirror image of an object  



Make different shapes of the same size
To do the following procedure, you must select an object that is an AutoShape.

1 Select the AutoShape whose size you want to copy.
2 On the Edit menu, click Duplicate.
3 On the Drawing toolbar, click Draw, point to Change AutoShape, point to the appropriate category, and then 

click the shape you want.



Create a mirror image of an object
1 Select the object you want to mirror.
2 On the Edit menu, click Duplicate.
3 On the Drawing toolbar, click Draw, point to Rotate or Flip, and then click Flip Horizontal or Flip Vertical.
4 Drag and position the duplicate object so it mirrors the original object.
Tip      To create a mirror image of clip art, you must first convert the clip art to a drawing object. Select the clip 

art, click Ungroup    , click Group    

, and then follow the preceding steps.



Make multiple duplicates and space them evenly
1 Select the object you want to duplicate.
2 On the Edit menu, click Duplicate.
3 Drag the duplicate to the position you want.
4 On the Edit menu, click Duplicate again for each duplicate you want positioned equally from the others.
Tip      You can create a perspective effect by scaling successive overlapping objects. Select the object you want 
to scale. On the Format menu, click Size. Under Scale, select the percentage of the original size you want in the
Height and Width boxes.



Copy attributes from one object to another
1 Select the object with the attributes you want to copy.

2 Click Format Painter    , and then click the object you want to copy the attributes to.
To copy all attributes of one object to several other objects, double-click Format Painter, and then click the 
objects one after another. When you're done, click Format Painter again.



Make a duplicate of an object
1 Click the object you want to duplicate.
2 On the Edit menu, click Duplicate.

To make additional duplicates, click Duplicate again.



Delete an object
1 Click the object you want to delete.
2 Press DELETE.





adjustment handle

A diamond-shaped handle used to adjust the appearance (not the size) of most AutoShapes. For example ¾ you 
can adjust a rounded rectangle to be more or less rounded, or you can adjust the arms of a cross to be thicker or
thinner.



attribute

An object or text feature you can change by using drawing tools and menu commands. Object attributes include 
line style, fill, shadow, color, and shape. Text attributes include font, style, color, size, and so on.



grid

An invisible matrix used to align objects automatically. If the grid is on as you draw or move objects, their corners 
align on the nearest intersection of the grid.



group

Two or more objects you treat as a single object. Groups can be composed of multiple sets of groups.



multiple selection

To select more than one object by holding down SHIFT and clicking the objects, or by dragging a selection 
rectangle around the objects. When you flip, rotate, and resize a multiple selection, all objects in the selection 
react independently.



picture

There are two kinds of pictures in this program: those you can ungroup and convert to objects (such as 
metafiles), and those you can’t (such as bitmaps). After you ungroup a picture, you can manipulate it with the 
drawing tools. When you select a picture, the Picture toolbar appears with tools you can use to change the 
attributes of a picture ¾ for example, to crop it or adjust its brightness.



sizing handle

A square handle that appears at each corner and along the sides of the rectangle that surrounds a selected 
object. Drag a sizing handle to resize an object.



vertex

The highest point of a curve, the point where a curve ends, or the point where two line segments meet in a 
polygon or freeform.



AutoShape

A group of ready-made shapes that include such basic shapes as rectangles and circles, plus a variety of lines, 
connectors, block arrows, flowchart symbols, stars and banners, and callouts.

To insert an AutoShape, click AutoShape on the Drawing toolbar. To attach text to an AutoShape ¾ except to a 
line, connector, or freeform ¾ click the shape and start typing. The text becomes part of the AutoShape.



bitmap

A picture made from a series of small dots that form shapes and lines. Bitmaps are created with paint programs 
such as Microsoft Paint, or by scanning an image. Bitmaps can’t be converted to drawing objects, although they 
can be scaled and cropped by using the tools on the Picture toolbar.



freeform

Any shape you draw by using the Curve, Freeform, and Scribble tools ¾ a puffy cloud, mountains, a lightning 
bolt, your name in cursive, and so on. Freeforms can include straight lines and freehand curves. They can be 
drawn open or closed and can be edited by using the drawing tools.



crop

To trim the edges of a picture by using the cropping tool on the Picture toolbar. After you crop a picture, you can 
always uncrop it. Photos are often cropped to focus attention on one particular area.



selection rectangle

The box formed by sizing handles after you select an object.



drawing object

Any shape you draw in Microsoft Draw, or any graphic or picture you change from its original format to the 
Microsoft Draw format ¾ for example, an AutoShape you draw or clip art you ungroup.



array

A series of evenly spaced objects.



sweep

A series of overlapping, evenly spaced objects.



tangent

A line that extends through a vertex. Dragging the end point of the tangent changes the shape of the curve. 





Save an object's attributes as the default style
1 Select the object that has the attributes you want to use as the default.
2 On the Drawing toolbar, click Draw, and then click Set AutoShape Defaults.
Tip      If you have text in an object, you can save the text style as a default. Select the text, click Font on the 
Format menu, and then select the Default for new objects check box.



Troubleshoot drawing objects

What do you need help with?

            The lines in my drawing are jagged.  
            Freehand drawing is hard to control.  
            Freeforms I drew won't align evenly.  
            I can't rotate an object.  
            I can't resize an object.  
            Colors within objects aren't smooth.  



The lines in my drawing are jagged.
· Curved lines ¾ and straight lines that are not perfectly vertical or horizontal ¾ will have some degree of 

jaggedness on the screen. When printed, the curves appear smooth.

· You can use the Curve tool        to draw precise curves. Your drawing will also appear smoother if you use 
the Freeform tool    

    instead of the Scribble tool    

.
· Try increasing the magnification in the Zoom box. It's easier to draw details at 200 percent.
· Try setting your mouse to the slowest tracking speed available in Windows Control Panel. You have greater 

control when you draw at a slow speed.
· You can adjust the shape of freeforms to make them look smoother. Select the freeform, click Edit Points on 

the Draw menu to make its vertexes appear, and then drag any vertex. It might help to increase the 
magnification in the Zoom box to 200 percent.

· You can smooth freeforms by removing individual vertexes. Select the freeform, and then click Edit Points on
the Draw menu to make its vertexes appear. Position the pointer over the vertex you want to delete, and then 
press CTRL as you click the vertex.



Freeforms I drew won't align evenly.
· Instead of using the Align or Distribute command on the Draw menu, try aligning the objects by moving 

them.
· Hold down CTRL and press the arrow keys to nudge the freeform in 1-pixel increments.

· If Snap to Grid        is turned on, temporarily turn it off by pressing ALT as you drag a freeform.



I can't rotate an object.
Only drawing objects can be flipped or rotated. If you can convert an object to a drawing object by ungrouping it 
and then grouping it again, you can flip or rotate it. However, you won't be able to convert a bitmap to a drawing 
object.

· To convert an object, select it, click Ungroup    , and then click Group    

.



Freehand drawing is hard to control.
· Try increasing the magnification in the Zoom box. It's easier to draw details at 200 percent.

· Use the Freeform tool        instead of the Scribble tool    

.
· Try setting your mouse to the slowest tracking speed available in Windows Control Panel. You have greater 
control when you draw at a slow speed.
· You can adjust the shape of freeforms to make them look smoother. For more information about changing 
the shape of freeforms, click    .



Colors within objects aren't smooth.
· Make sure the magnification in the Zoom box is set to 100 percent. Shading patterns can appear distorted at 

reduced or enlarged views.
· If your monitor is capable of showing only 16 colors, shading might not appear smooth. Shading shows up 

best on monitors that display 256 or more colors.



I can't resize an object.
The Lock aspect ratio option is selected.

· On the Format menu, click Size, and then clear the Lock aspect ratio check box.



Ways to insert pictures

You can insert a picture by clicking Insert Clip Art        and then clicking the Clip Art or Pictures tab. For 
more information about the Clip Gallery, click    

.
You can also insert pictures and scanned photographs from other programs and locations by clicking Insert Picture 

from File    . When you select a picture, the Picture toolbar appears with tools you can use to crop the picture, 
add a border to it, and adjust its brightness and contrast.

There are two types of pictures ¾ bitmaps, which can't be ungrouped, and pictures such as metafiles that can be 
ungrouped, converted to drawing objects, and then edited with the drawing tools. Most clip art is in metafile 

format. To ungroup and convert clip art to a drawing object, just select it, and then click Ungroup    . You can 
then modify it just as you can any other object you draw. For example ¾ you might insert an image of a person, 
ungroup it, change the color of the person's clothing, and then add the modified image to another clip art image.



Insert and edit clip art or a picture
You can insert clip art or a picture from the Clip Gallery, or you can insert a picture or scanned photo from 
another program and location. When you insert clip art, you can convert the image to drawing objects and use 
the drawing tools to edit the objects ¾ for example, to change the fill or line colors, rearrange parts, or combine 

images. For more information about the Clip Gallery, click    .

When you select a picture, the Picture toolbar appears with tools you can use to change the brightness or contrast of
the picture or to crop, recolor, or add a border to it.

What do you want to do?

              Insert clip art or a picture from the Clip Gallery  

              Insert an imported picture  

              Ungroup and modify clip art  

              Edit a picture  

              Create transparent areas in a picture  



              Replace a clip art image  



Insert an imported picture

1 Click Insert Picture from File    .
2 Locate the folder that contains the picture you want to insert.
3 Double-click the picture.



Edit a picture
1 Select the picture you want to edit.
2 On the Picture toolbar, select the options you want.
Tip      If you don't like the changes you made and want to return the picture to its original settings, click Reset 

Picture        on the Picture toolbar.



Troubleshoot working with pictures

What do you need help with?

          I can't change the color of some parts of a picture. I can only change the fill, line, or shadow of its border.  

          I can't ungroup an imported picture.  



I can't change the color of some parts of a picture. I can only change the fill, line, or 
shadow of its border.
The picture is a bitmap, which can't be ungrouped and converted to a drawing object, or the picture may have 
smaller groups within it that are not ungrouped.

· To ungroup the picture, select it and click Ungroup    . Then use the drawing tools to change the colors.



I can't ungroup an imported picture.
The image is a bitmap, which can't be ungrouped and converted to a drawing object.

You can modify the image in an imaging program. For example ¾ to flip or rotate a bitmap image, open it in a 
program such as Microsoft Photo Editor, flip or rotate it there, save the changes, and then insert it in your 
drawing.



Create transparent areas in a picture
You can use transparent areas to integrate a picture on your page ¾ for example, when you have a picture of a 
person and don't want the background color to be visible.

1 Select the picture you want to create transparent areas in.

2 On the Picture toolbar, click Set Transparent Color    .
3 Click the color you want to make transparent.

Notes
· The Set Transparent Color tool is available for bitmap pictures that don't already have transparency 

information. It's also available for some, but not all, clip art.
· You can make only one color transparent. When printed, transparent areas will be the same color as the 

paper they're printed on. In an electronic display ¾ such as on a Web page or in a PowerPoint presentation ¾ 
transparent areas will be the same color as the background.

· It might be difficult to see the transparent effect in a photograph because the color you select may appear in 
very small areas. What appears to be a single color, such as a blue sky, can actually be a range of subtle 
color variations.





Turns the text inside the AutoShape a quarter turn (90 degrees) to the right.



Applies line breaking options.



Applies line breaking options.



Applies line breaking options.



Applies font alignment options.



Change Text Direction

Positions text in a text box or AutoShape horizontally, left to right, or vertically, bottom to top.



Distributed Paragraph

Evenly distributes the characters in a paragraph between the left and right margins with horizontal text, and 
between the upper and lower margins with vertical text.



Vertical Text Box

Draws a text box in which you can add vertical text. Use a text box to add text — such as captions or callouts — 
to your pictures or graphics.



Recently Used Colors

These are the nonstandard font colors you most recently used. Click a color here to quickly use it again.



Displays additional font colors.





Add, change, or remove a fill
You can fill objects with solid or gradient (shaded) colors, a pattern, a texture, or a picture. Any time you fill an 
object, the new fill replaces the old one. If you change an object's fill, you can easily change it back to its default.

What do you want to do?

          Add or change a fill color  

          Add or change a gradient (shaded), patterned, textured, or picture fill  

          Change the defaults for line style and fill  

          Remove a fill  



Change the defaults for line style and fill
1 Select the object that has the line style and fill you want.
2 On the Format menu, click Colors and Lines.
3 Select the Default for new objects check box.



Add or change a fill color
1 Select the object you want to change.

2 On the Drawing toolbar, click the arrow next to Fill Color    .
3 Click the color you want.

If you don't see the color you want, click More Colors. Click a color on the Standard tab, or click the Custom 
tab to mix your own color, and then click OK.



Add or change a gradient (shaded), patterned, textured, or picture fill
1 Select the object you want to change.

2 On the Drawing toolbar, click the arrow next to Fill Color    , click Fill Effects, and then click the 
Gradient, Texture, Pattern, or Picture tab.

3 Select the options you want.
For Help on an option, click the question mark        and then click the option.



Remove a fill
1 Select the object you want to change.

2 On the Drawing toolbar, click the arrow next to Fill Color    , and then click No Fill.





Click Select Picture to use a picture as the fill for the selected object. The picture stretches to completely fill the 
object.



Displays the name of the selected picture.



Click the way you want the picture to fill the selected chart elements. Stretch resizes a single instance of the 
picture so it completely fills the selected chart elements. Stack fills the selected chart elements with horizontally 
and vertically tiled repetitions of the original-sized picture. Stack and Scale to resizes the picture, so the number
of repetitions you enter in the Units/Picture box fills the selected chart elements vertically. A smaller number in 
the Units/Picture box means more repetitions of the picture, which may increase the amount of memory used 
and the time it takes to draw the fill on the screen.



Select which faces of the selected chart elements you want to fill with the picture. If you clear a check box (or 
later click Clear Formats on the Edit menu), the face retains the last-applied color formatting. The name of each 
face is assigned when you initially insert the picture and does not change if you later rotate the object — for 
example, the Front face is called Front even if you rotate it to the side.



Click the color settings you want for the gradient fill. For more information about each color setting, click        
and then click the option.



Fills the selected object with a single color that fades gradually to black or white. Click the color you want in the 
Color 1 box, and then drag the Dark/Light slider to adjust the intensity of the color.



Fills the selected object with one color that fades gradually to another color. Click the colors you want in the 
Color 1 and Color 2 boxes.



Fills the selected object from a set of specially created gradient fills. Click the name of the color set you want in 
the Preset colors box.



Click the color you want. If you clicked One Color, this color will fade gradually to black or white. If you clicked 
Two colors, this color will fade into the color you click in the Color 2 box.



Click the name of the built-in color set you want to use for a gradient (shaded) fill.



Click the color you want for the second color of a two-color gradient (shaded) fill. 



Drag the slider toward Dark to make the color fade gradually to black. Drag the slider toward Light to make the 
color fade gradually to white. 



Click the gradient (shaded) fill style you want, and then click a variation of the style under Variants.



First, click the fill style you want under Shading Styles, then click a variation of the style under Variants.



Click the special texture you want to use as the fill for the selected object. The name of the texture you click 
appears in the description box below. To add a texture to the list, click Other Texture.



Opens a different file that you can use as a textured fill. You can use a Windows Bitmap (a .bmp or .dib file) or 
Windows Metafile ( a .wmf or .emf file) as a textured fill. You can also use any graphics file for which you have an
import filter installed; for example, you can use a JPEG file (.jpg) if the JPEG import filter is installed on your 
computer.



Click the fill pattern you want. To change the pattern colors, click new colors in the Foreground and 
Background boxes.



Describes the pattern, texture, or picture you clicked above.



Click the foreground color you want for the pattern.



Click the background color you want for the pattern.



Shows what the selected options will look like if you click OK.





Rotate or flip an object
You can rotate an object 90 degrees to the left or right or to any other angle. You can also flip an object 
horizontally or vertically. You can flip or rotate one object, multiple objects at the same time, or a group of objects.
If the object is an AutoShape with attached text, the text rotates or flips with the shape.

Some pictures and clip art that you import can't be rotated or flipped because they weren't created in Microsoft 
Draw. If you can ungroup an imported object and then regroup its components, you might be able to flip or rotate 
it. You cannot flip or rotate bitmaps, however.

What do you want to do?

            Flip an object horizontally or vertically  
            Rotate an object 90 degrees  
            Rotate an object to any angle  



Rotate an object to any angle
1 Select the object you want to rotate.

2 On the Drawing toolbar, click Free Rotate    .
3 Drag a corner of the object in the direction you want to rotate it.
4 Click outside the object to set the rotation.

Tips
· To constrain the rotation of the object to 15-degree angles, hold down SHIFT while you use the Free Rotate 

tool.
· To rotate the object around the handle opposite the handle you're dragging, hold down CTRL while you use 

the Free Rotate tool.
· To rotate several objects at once, click the objects while holding down SHIFT, and then use the Free Rotate 

tool.



Rotate an object 90 degrees
1 Select the object you want to rotate.
2 On the Drawing toolbar, click Draw, point to Rotate or Flip, and then click Rotate Left or Rotate Right.



Flip an object horizontally or vertically
1 Select the object you want to flip.
2 On the Drawing toolbar, click Draw, point to Rotate or Flip, and then click Flip Horizontal or Flip Vertical.





Click the line color you want for the selected AutoShape. Click Patterned Lines if you want to add a pattern to 
the line.



Click the line style you want. If you want a thicker or thinner line, click a line style, and then change the Weight 
setting.



Displays the weight of the currently selected Style. To make that line thinner or thicker, enter a new value in the 
Weight box.



Click a dashed-line style, or click the solid line if you don't want a dashed line.



Click the connector style you want for the selected object. Connectors are lines that connect objects and remain 
attached even if you rearrange the objects. This option is available only when the selected object is a connector 
line.



Click the arrow style you want for the beginning of the selected line. If you don't want an arrow on this end of the 
selected line, click the straight line.



Click the arrow style you want for the end of the selected line. If you don't want an arrow on this end of the 
selected line, click the straight line.



Click the arrow size you want for the beginning of the selected line. To remove the arrow, click the straight line in 
the Begin style box.



Click the arrow size you want for the end of the selected line. To remove the arrow, click the straight line in the 
End style box.



Click the fill color you want for the selected AutoShape. Click Fill Effects if you want to use a pattern, gradient, 
texture, or picture fill.



Uses the currently selected options as the default settings for all new AutoShapes you insert in your 
presentations.



Makes the selected solid-color fill partially transparent. Clear this check box to make the selected fill completely 
opaque. This check box is unavailable if the selected object contains a gradient, texture, pattern, or picture fill 
effect.



Moves the selected object up or down on the page if you move the paragraph the object is anchored to. When 
you select this check box, Word changes Horizontal from to Column and changes Vertical from to Paragraph.
Word clears this check box if you change the Vertical from or Horizontal from settings.



Keeps the selected object on the same page as the text it is anchored to. The object can move with its anchor, 
but it always stays on the same page as the anchor.



Enter the height you want for the selected object. The Height and Width settings are always the dimensions of 
an unrotated object. Alternatively, you can adjust the height as a percentage of the original size by entering a 
percentage in the Height box under Scale. If the Lock aspect ratio check box is selected, the Height and 
Width settings change in relation to one another.



Enter the width you want for the selected object. The Height and Width settings are always the dimensions of an
unrotated object. Alternatively, you can adjust the width as a percentage of the original size by entering a 
percentage in the Width box under Scale. If the Lock aspect ratio check box is selected, the Height and Width
settings change in relation to one another.



Enter the height you want for the selected object as a percentage of the original size. The Height and Width 
settings are always the dimensions of an unrotated object. Alternatively, you can adjust the height by entering an 
exact measurement in the Height box under Size and rotate. If the Lock aspect ratio check box is selected, the
Height and Width settings change in relation to one another.



Enter the width you want for the selected object as a percentage of the original size. The Height and Width 
settings are always the dimensions of an unrotated object. Alternatively, you can adjust the width by entering an 
exact measurement in the Width box under Size and rotate. If the Lock aspect ratio check box is selected, the 
Height and Width settings change in relation to one another.



Enter the amount, in degrees (from 0 [zero] to 359), by which you want to rotate the selected AutoShape in the 
clockwise direction. The Height and Width settings are always the dimensions of an unrotated object. 



Constrains the height and width of the selected object so they stay in their original proportion to one another. If 
you change the height of the object, the width changes in relation to the original aspect ratio, and vice versa.



Calculates the height and width percentages under Scale, based on the original size of the picture. This option is
available only when the selected object is a picture.



Automatically adjusts the size of the selected picture to the ideal size for viewing in a slide show. If you select this
check box, click the resolution of your slide show monitor in the Resolution box. This check box is available only
when the selected object is a picture.



Click the resolution of your slide show monitor. PowerPoint automatically calculates the best picture size for the 
monitor you will use for the slide show. This option is available only when the Best scale for slide show check 
box is selected.



This is the original size of the selected picture. The settings under Original size are available only when the 
current selection is a picture.



Returns the selected picture to its original size. This button is available only when the current selection is a 
picture.



Enter the amount you want to trim off the left side of the selected picture. Enter a negative number to add white 
space to the left side. All the settings under Crop from are relative to an unscaled picture.



Enter the amount you want to trim off the top of the selected picture. Enter a negative number to add white space
to the top of the picture. All the settings under Crop from are relative to an unscaled picture.



Enter the amount you want to trim off the right side of the selected picture. Enter a negative number to add white 
space to the right side. All the settings under Crop from are relative to an unscaled picture.



Enter the amount you want to trim off the bottom of the selected picture. Enter a negative number to add white 
space to the bottom of the picture. All the settings under Crop from are relative to an unscaled picture.



Click Automatic to use the picture's original colors. Click Grayscale to convert a color picture to black and white.
Each color converts to an equivalent grayscale level. Click Black & White to convert the picture to pure black 
and white (also known as line art). Click Watermark to format the picture with preset brightness and contrast 
settings that work well for watermarks.



Drag the slider to set the contrast (saturation or intensity) of the color or enter a percentage in the % box. The 
higher the percentage, the more intense the color. The lower the percentage, the more gray the color.



Opens the Recolor dialog box, where you can change the colors of the selected picture.



Removes cropping from the selected picture, and returns the color, brightness, and contrast to the original 
settings.



Enter the amount of space you want between the left edge of the object and the left edge of the Microsoft Draw 
object. Position settings are always relative to an unrotated object.



Click the point from which you want to position the left edge of the selected AutoShape. 



Enter the amount of space you want between the top edge of the object and the top of the Microsoft Draw object.
Position settings are always relative to an unrotated object.



Click the point from which you want to position the top edge of the selected object. 



Click the point to which you want to anchor the text in the selected text box. This setting is relative to the text box.



Enter the amount of space you want between the left edge of the selected text box and the text inside it.



Enter the amount of space you want between the right edge of the selected text box and the text inside it.



Enter the amount of space you want between the top edge of the selected text box and the text inside it.



Enter the amount of space you want between the bottom edge of the selected text box and the text inside it.



Adjusts text to fit horizontally in the selected AutoShape.



Turns the text inside the AutoShape a quarter turn (90 degrees) to the right. 



Adjusts the size of the AutoShape so it encompasses the text inside it.



Turns the text inside the AutoShape a quarter turn (90 degrees) to the right.



Shows how your document will look if you click OK. 



Click the options you want for the fill color of the selected object.



Click the line color and line style options you want for the selected object.



Click the style and size you want for each end of your arrow. If you don't want arrows, click the straight line in the 
Begin style and End style boxes. The options under Arrows are available only if the selected object is a line. 



There are two ways to change the size of the selected object: by entering exact height and width measurements 
under Size and rotate, or by entering height and width measurements as a percentage of the original size under 
Scale. If the Lock aspect ratio check box is selected, the Height and Width settings change in relation to one 
another.



There are two ways to change the size of the selected object: by entering exact height and width measurements 
under Size and rotate, or by entering height and width measurements as a percentage of the original size under 
Scale. If the Lock aspect ratio check box is selected, the Height and Width settings change in relation to one 
another.



Cuts off (crops) the parts of the picture you enter. Enter negative numbers to add white space around the 

selected picture. To crop a picture by using the mouse, click the Crop        on the Picture toolbar, and then 
drag a sizing handle on the picture.



Changes the color, brightness, and contrast of the selected picture object.



Sets the horizontal and vertical position of the selected object relative to the edge of the Microsoft Draw object.



Enter the amount of space you want between the edges of the selected text box and the text inside it.



Drag the slider to set the brightness (the amount of black or white added to the color), or enter a percentage in 
the % box. The higher the percentage, the lighter — more white — the color. The lower the percentage, the 
darker — more black — the color.



Applies and saves any changes you have made and then closes this dialog box.



The Cancel button closes this dialog box without saving any changes you have made. The Close button closes 
this dialog box and retains the changes you made.



Turns the text inside the AutoShape a quarter turn (90 degrees) to the right. 





Group, ungroup, and regroup objects
When you group objects, you combine them so you can work with them as though they were a single object. You 
can flip, rotate, and resize or scale all objects in a group as a single unit. You can also change the attributes of all
objects in a group at one time ¾ for example, you might change the fill color or add a shadow to all objects in the 
group. You can create groups within groups to help you build complex drawings.

You can ungroup a group of objects at any time, and you can easily regroup them after you select any one of the 
ungrouped objects.

Note      If the group includes a bitmap picture, the group can't be flipped or rotated.

What do you want to do?

          Group objects  

          Ungroup objects  

          Regroup objects  



Stack objects and move through the stack
Objects automatically stack in individual layers as you add them to a drawing. You see the stacking order when 
objects overlap ¾ the top object covers a portion of objects beneath it. If you "lose" an object in a stack, you can 
press TAB to cycle forward (or SHIFT+TAB to cycle backward) through the stack until the object is selected.

You can move individual objects or groups of objects in a stack. For example ¾ you can move objects up or 
down within a stack one layer at a time, or you can move them to the top or bottom of a stack in one move. You 
don't have to draw the bottom object first ¾ you can always move it later. You can overlap objects to create 
different effects.

What do you want to do?

          Bring an object to the front or back  

          Bring an object one step closer to the front or back  



Bring an object to the front or back
1 Select the object you want to move.

If the object is hidden, press TAB or SHIFT+TAB until it's selected.
2 On the Draw menu, point to Order, and then click Bring to Front or Send to Back.
Tip      You can use the Order button on the Formatting toolbar when you want to repeat the same command two
or more times in succession.



Bring an object one step closer to the front or back
1 Select the object you want to move.

If the object is hidden, press TAB or SHIFT+TAB until it's selected.
2 On the Draw menu, point to Order, and then click Bring Forward or Send Backward.
Tip      You can use the Order button on the Formatting toolbar when you want to repeat the same command two
or more times in succession.



Group objects
1 Select the objects you want to group by holding down SHIFT as you click each one.

2 Click Group    .



Ungroup objects
1 Select the group you want to ungroup.

2 Click Ungroup    .



Regroup objects
1 Select any one of the objects that were previously grouped.

2 Click Regroup    .
Note      The Regroup command is unavailable if the object you select is part of another group.





Click the design you want for your text effect. To change the shape later, select the text effect, and click WordArt 

Shape        on the WordArt toolbar.



Click the new design you want for your text effect.





Keyboard-mouse combinations

For drawing an AutoShape

To Hold down
Draw a perfect square, circle, or 
other shape that can be inscribed 
within a square 

SHIFT and drag

Draw an AutoShape from its center 
outward

CTRL and drag

Temporarily turn the snap-to-grid 
feature on or off as you draw

ALT and drag

For drawing a line

To Hold down
Draw a line at an angle that's a 
multiple of 15 degrees

SHIFT and drag

Draw a line from its center outward CTRL and drag

For drawing a connector

To Hold down
Draw a straight connector at an angle
that's a multiple of 15 degrees

SHIFT and drag

For moving an object

To Hold down
Move an object horizontally or 
vertically

SHIFT and drag

Copy an object CTRL and drag

For moving a line

To Hold down
Lengthen or shorten a line while 
maintaining its orientation

SHIFT and drag 
the end point

Reposition a line about its center CTRL and drag 
the end point

For resizing an object or picture

To Hold down
Resize the object or picture from its 
center outward

CTRL and drag 
any sizing handle

For cropping a picture

On the Picture toolbar, click Crop    .

To Hold down
Move the cropped picture horizontally
or vertically

SHIFT and drag

Define the cropped area from the 
center outward

CTRL and drag 
any cropping 
handle

Copy a cropped picture CTRL and drag



For rotating an object

On the Drawing toolbar, click Free Rotate    .

To rotate an object Hold down
In 15-degree increments SHIFT and drag 

the pointer
About the opposite corner CTRL and drag 

the pointer

For working with vertexes on curves and freeforms

On the Drawing toolbar, click Draw, and then click Edit Points.

To add a vertex, click and drag where you want to add it. Right-click a vertex and click Smooth Point, Straight 
Point, or Corner Point to make a tangent appear. 

To Hold down
Switch the tangent to corner mode SHIFT and drag 

the end point
Delete a vertex CTRL and click the

vertex
Temporarily turn the snap-to-grid on 
or off as you move a vertex or 
tangent end point

ALT and drag the 
vertex or end 
point

Switch the tangent to symmetrical 
mode

CTRL and drag 
the end point



Change the color of a line or border
1 Select the object you want to change.

2 On the Drawing toolbar, click the arrow next to Line Color    .
3 Click the color you want.

If you don't see the color you want, click More Line Colors. Click a color on the Standard tab, or click the 
Custom tab to mix your own color, and then click OK.



Remove a border
1 Select the object whose border you want to remove.

2 On the Drawing toolbar, click the arrow next to Line Color    , and then click No Line.



Curves and freeforms
The AutoShapes menu on the Drawing toolbar includes several categories of tools for creating shapes. In the 
Lines category, you can use the Curve    , Scribble    

, and Freeform    
    tools to draw lines and curves, as well as shapes that combine both lines and curves. When you want an object 

to look as if it were drawn with a pen, use the Scribble tool. The resulting shape closely matches what you draw on 
the screen. Use the Freeform tool when you want a more refined shape ¾ one without jagged lines or drastic 
changes in direction.

When you want to draw curves with greater control and accuracy, use the Curve tool. To change the basic shape
of a curve or freeform by moving, deleting, and adding vertexes, click Edit Points on the Draw menu (Drawing 
toolbar).

You can enhance freeforms and curves just as you can AutoShapes ¾ for example, you can add a color or 
pattern, change their line styles, flip or rotate them, and add text ¾ but you can't convert a freeform or a curve to 
an AutoShape.



Change the shape of a freeform or curve
1 Select the freeform object or curve you want to change.
2 On the Drawing toolbar, click Draw, and then click Edit Points.
3 To reshape the freeform, drag one of the vertexes that form its outline.

To add a vertex to the freeform, click where you want to add it, and then drag.
To delete a vertex, press CTRL and click the vertex you want to delete.

Tip      For greater control over the shape of a curve, after you click Edit Points, right-click a vertex. A shortcut 
menu appears with options for other types of vertexes you can use to refine the shape of the curve.



Add, move, or reroute a connector line
You can use three types of connector lines to connect objects ¾ straight, elbow, and curved. When you 
rearrange objects, the connectors remain attached. If you move either end of a connector, that end detaches 
from the object. You can then attach it to another connection site on the same object, or you can attach it to 
another object. To detach the entire connector, just drag its middle.

If you rearrange connected objects, some connectors might need to be rerouted to make the most direct 
connections and to keep connectors from crossing objects.

What do you want to do?

            Add or move a connector line  
            Reroute a connector line  



Add or move a connector line
1 On the Drawing toolbar, click AutoShapes, point to Connectors, and then click the connector you want.
2 Point to where you want to attach the connector.

Connection sites appear as blue squares.
3 Click the connection site, drag the connector to where you want to attach it to the other object, and then click 

another connection site.
Locked connectors appear as red squares. Unlocked connectors appear as green squares.

4 To move the connector line, drag one of its ends and connect it to another site or object. 
To detach the entire line, drag its middle. 
To maintain a connector's angle while repositioning an end point, hold down SHIFT as you drag the end point.

            



Reroute a connector line
1 Select one of the connected objects.

2 Click Reroute Connectors    .

Tip      If you click Reroute Connectors when two or more connector lines are connecting the same two objects, 
all the lines move so they connect at the same points. If you don't want to reroute all the lines, select only the line
you want to reroute, and then click Reroute Connectors.



Draw a curve
1 On the Drawing toolbar, click AutoShapes, point to Lines, and then click Curve    .

2 Click where you want the shape to start, and then continue to move the mouse and click wherever you want 
to add a curve.
3 To end the shape and leave it open, double-click it at any point.

To close the shape, click near its starting point.



Draw a freeform object
1 On the Drawing toolbar, click AutoShapes, and then point to Lines.
2 Click Freeform        to draw an object with both curved and straight segments. Drag to draw freehand 

shapes; click, move the mouse, and click again to draw straight lines.
Click Scribble        when you want an object to look as if it were drawn with a pen.

3 To end a shape and leave it open, double-click it at any point.
To close a shape, click near its starting point.



Draw a line
1 On the Drawing toolbar, click AutoShapes, point to Lines, and then click the line style you want.
2 Drag to draw the line.

To constrain the line to draw at an angle that's a multiple of 15 degrees, hold down SHIFT as you drag.
To lengthen the line in both directions as you draw it, hold down CTRL as you drag.

Tip      If you just want to draw a plain straight line, click Line        on the Drawing toolbar.



Add or remove arrowheads
1 Select the line or other object you want to change.

2 On the Drawing toolbar, click Arrow Style    .
3 To add an arrowhead, click the style you want; or click More Arrows, and then click the arrowhead style you
want.

To remove an arrowhead, click the line without arrowheads at the top of the menu.
Tip      You can add arrowheads to any line, including curves and open freeforms. You can also add arrowheads 
to some other objects ¾ such as the line callouts in the Callouts category on the AutoShapes menu.



Change the thickness and style of a line or border
1 Select the line or border you want to change.

2 On the Drawing toolbar, click Line Style    .
3 Click the style you want, or click More Lines and then click the options you want.



Make a dashed line or border
1 Select the line or border you want to change.

2 On the Drawing toolbar, click Dash Style    , and then click the style you want.



Troubleshoot freeforms

What do you need help with?

            The lines in my drawing are jagged.  
            Freehand drawing is hard to control.  
            Freeforms I drew won't align evenly.  



Add, change, or remove a line or border
You can modify the border of any object ¾ including a text box ¾ by changing its color, thickness, and style. You 
can change a border from a solid line to one of eight styles of dashed lines. If you remove a border, you might 
want to make sure the object's fill color is different from the background color, or your object will seem to 
disappear.

What do you want to do?

            Change the color of a line or border  
            Change the thickness and style of a line or border  
            Make a dashed line or border  
            Remove a border  





Save (File menu)

Saves the active file with its current file name, location, and file format.



Print (File menu)

Prints the active file or selected items. To select print options, on the File menu, click Print.



Bullets

Adds bullets to or removes bullets from selected paragraphs.



Drawing

Shows or hides the Drawing toolbar.



New (File menu)

Creates a new, blank file.



Copy (Edit menu)

Copies the selection to the Clipboard.



Undo (Edit menu)

Reverses your last action. Each click reverses one more action. The command name changes to Can't Undo if 
you cannot undo the previous action.



Cut (Edit menu)

Removes the selection from the active document and places it on the Clipboard.



Paste (Edit menu)

Inserts the contents of the Clipboard at the insertion point, and replaces any selection. This command is 
available only if you have cut or copied an object, text, or contents of a cell.



Open (File menu)

Opens or finds a file.



Zoom

Controls how large or small a document appears on the screen.



Repeat

Repeats your last command or action, if possible. The Repeat command changes to Can't Repeat if you cannot 
repeat the last action. When you use the Undo command to reverse an action, the Repeat command changes to
Redo. The Redo command reverses the action of the Undo command.



Clear (Edit menu)

Deletes the selected object or text without putting it on the Clipboard. This command is available only if an object 
or text is selected. 





Close (File menu)

Closes the active file without exiting the application. If the file contains any unsaved changes, you will be 
prompted to save the file before closing. To close all open files, hold down SHIFT and click Close All on the File 
menu.



Format Painter (Standard toolbar)

Copies the format from a selected object or text and applies it to the object or text you click. To copy the 
formatting to more than one item, double-click    , and then click each item you want to format. When you are 
finished, press ESC or click    

    again to turn off the Format Painter.



Print Preview (File menu)

Shows how a file will look when you print it. 



Bold (Formatting toolbar)

Makes selected text and numbers bold. If the selection is already bold, clicking        removes bold formatting.



Italic (Formatting toolbar)

Makes selected text and numbers italic. If the selection is already italic, clicking        removes italic formatting.



Underline (Formatting toolbar)

Underlines selected text and numbers. If the selection is already underlined, clicking        removes underlining.



Align Left (Formatting toolbar)

Aligns the selected text, numbers, or inline objects to the left with a ragged right edge.



Align Right (Formatting toolbar)

Aligns the selected text, numbers, or inline objects to the right with a ragged left edge.



Center (Formatting toolbar)

Centers the selected text, numbers, or inline objects.



Justify (Formatting toolbar)

Aligns the selected paragraphs to both the left and right margins or indents.



Undo (Edit menu)

Reverses the last command or deletes the last entry you typed. To reverse more than one action at a time, click 

the arrow next to    , and then click the actions you want to undo. The command name changes to Can't Undo
if you cannot reverse the last action.



Redo (Edit menu)

Reverses the action of the Undo command. To redo more than one action at a time, click the arrow next to    , 
and then click the actions you want to redo.



Line (Drawing toolbar)

Draws a straight line where you click or drag in the active window. To constrain the line to draw at 15-degree 
angles from its starting point, hold down SHIFT as you drag.



Rectangle (Drawing toolbar)

Draws a rectangle where you click or drag in the active window. To draw a square, hold down SHIFT while you 
drag.



Text Box (Drawing toolbar)

Draws a text box where you click or drag in the active window. Use a text box to add text — such as captions or 
callouts — to your pictures or graphics.



Oval (Drawing toolbar)

Draws an oval where you click or drag in the active window. To draw a circle, hold down SHIFT while you drag.



Arc

Draws an arc where you click or drag in the active window. To define the shape within a perfect square, hold 
down SHIFT while you drag.



Group

Assembles two or more selected objects into a single object so they can be moved or changed as a group.



Ungroup

Disassembles a grouped object into individual objects so each can be moved or changed individually.



Bring to Front (Draw menu, Order command)

Places the selected object in front of other overlapping objects.



Send to Back (Draw menu, Order command)

Places the selected object behind other overlapping objects.



Bring in Front of Text (Draw menu, Order command)

Places the selected drawing object in front of text.



Send Behind Text (Draw menu, Order command)

Places the selected drawing object behind text.



Bring Forward (Draw menu, Order command)

Moves the selected object or group one step closer to the top of a stack of objects.



Send Backward (Draw menu, Order command)

Moves the selected object or group one step closer to the bottom of a stack of objects.



Ruler (View menu)

Displays or hides the horizontal ruler, which you can use to position objects, change paragraph indents, page 
margins, and other spacing settings.



Rounded Rectangle

Draws a rectangle with rounded corners where you click or drag in the active window. To draw a square, hold 
down SHIFT while you drag.



Select Objects

Changes the pointer to a selection arrow so you can select objects in the active window. To select a single object,
click the object with the arrow. To select one or more objects, drag the arrow over the objects you want to select.



Flip Horizontal

Flips the selected drawing object horizontally 180 degrees. This command is not available if the selected object 
cannot be rotated — a picture or an OLE object, for example.



Flip Vertical

Flips the selected drawing object or group vertically 180 degrees, that is, from top to bottom. This command is 
not available if the selected object cannot be rotated — a picture or an OLE object, for example.



Rotate Right

Rotates the selected drawing object 90 degrees to the right. This command is not available if the selected object 
cannot be rotated — a picture or an OLE object, for example.



Rotate Left

Rotates the selected object 90 degrees to the left. This command is not available if the selected object cannot be
rotated — a picture or an OLE object, for example.





Freeform

Draws an object with both curved and straight segments. Drag to draw freehand shapes; click and move the 
mouse to draw straight lines. To end a shape and leave it open, double-click it at any point. To close a shape, 
click near its starting point.



Callout

Draws a callout where you click or drag in the active window.



Drawing

Displays or hides the Drawing toolbar.



Edit Points (Draw menu)

Displays the vertices so you can change the shape of the selected freeform drawing object or curve. To reshape 
the freeform, drag one of the vertices that form its outline. To add a vertex to the freeform, click where you want 
to add it, and then drag. To delete a vertex, press CTRL and click the vertex you want to delete.



Properties

Changes the properties of the ActiveX controls in the file, or changes the options for the selected form field.



Align

Aligns selected drawing objects with one another or with the page.



Arrow

Inserts a line with an arrowhead where you click or drag in the active window. To constrain the line to draw at 15-
degree angles from its starting point, hold down SHIFT as you drag.



Page Setup (File menu)

Sets margins, paper source, paper size, page orientation, and other layout options for the active file.



Font (Format menu)

Changes the font and character spacing formats of the selected text.



Font Size

Changes the size of the selected text and numbers. In the Font Size box, enter a size. The sizes in the Font 
Size box depend on the selected font and active printer.



Send

Sends the active file as an attachment to an electronic mail message.



Add Routing Slip

Sends the active file to reviewers to change and add comments. To use routing, you and those you are sending 
the document to must have installed both the application in which the document was created and Microsoft 
Exchange or a compatible mail package.

When you have an existing routing slip or a message has been sent to you with a routing slip, the command 
name changes to Edit Routing Slip.



WordArt Gallery

Creates text effects by inserting a Microsoft WordArt object.



Microsoft Mail

Starts Microsoft Mail or switches to it if it is already running.



Microsoft Excel

Starts Microsoft Excel or switches to it if it is already running.



Microsoft Access

Starts Microsoft Access or switches to it if it is already running.



Microsoft Schedule+

Starts Microsoft Schedule+ or switches to it if it is already running.



Microsoft Visual FoxPro

Starts Microsoft Visual FoxPro or switches to it if it is already running.



Microsoft PowerPoint

Starts Microsoft PowerPoint or switches to it if it is already running.



Microsoft Publisher

Starts Microsoft Publisher or switches to it if it is already running.



Microsoft Project

Starts Microsoft Project or switches to it if it is already running.



Microsoft Bookshelf

Starts Microsoft Bookshelf or switches to it if it is already running.



Arrange (Window menu)

Displays all open files in separate windows on the screen. The Arrange command makes it easier to drag 
between files.





Split (Window menu)

Splits the active window into panes, or removes the split from the active window.



New Window (Window menu)

Opens a new window with the same contents as the active window so you can view different parts of a file at the 
same time.



Disassemble Picture

Separates the selected metafile picture into distinct drawing objects.



Shrink Font 1 Pt

Decreases the font size of selected text by one point.



Grow Font 1 Pt

Increases the font size of selected text by one point.



Start of Line

Moves the insertion point to the beginning of the current line.



End of Line

Moves the insertion point to the end of the current line.



Page Up

Moves the insertion point and document display to the previous screen of text.



Page Down

Moves the insertion point and document display to the next screen of text.



Vertical Textbox

Draws a text box where you click or drag so you can add text to a graphic.



Send Mail

Sends the message or file.



Close, Close All (File menu)

Closes the active file without exiting the application, prompting you to save if the file contains unsaved changes. 
To close all open files, hold down SHIFT and click Close All on the File menu.



Repeat (Edit menu)

Repeats your last command or action, if possible. The Repeat command changes to Can't Repeat if you cannot 
repeat the last action.

When you use the Undo command to reverse an action, the Repeat command changes to Redo. The Redo 
command reverses the action of the Undo command.



Regroup

Reassembles a group of objects that have been disassembled using the Ungroup command.



3-D

Adds a three-dimensional effect to the selected object.



Shadow

Adds a shadow to the selected object.



Tip Wizard

Shows tips about more efficient ways to accomplish tasks, and suggests related and new features.





Font Color

Formats the selected text with the color you click.



Merge and Center

Combines two or more selected adjacent cells to create a single cell. The resulting merged cell contains only the 
upper left-most data in the selection, which is centered within the cell. The cell reference for a merged cell is the 
upper-left cell in the original selected range.



Increase Font Size

Increases the font size of the selected text to the next larger size in the Font Size box.



Decrease Font Size

Decreases the font size of the selected text to the next smaller size in the Font Size box.



Vertical Text

Aligns selected text vertically, with each character below the previous one, so that you read it from top to bottom.



Rotate Text Up

Turns the selected text on its left side so that you read it from bottom to top.



Rotate Text Down

Turns the selected text on its right side so that you read it from top to bottom.



Distribute Horizontally

Distributes the selected objects horizontally, relative to one another. Horizontal distribution moves the selected 
objects so there is equal horizontal distance between the edges of all the objects.



Scribble

Draws freehand where you drag in the active window. To end a shape and leave it open, release the mouse 
button. To close a shape, release the mouse button near its starting point.



Select Graphics

Changes the pointer to a cross hair so you can drag a selection rectangle around multiple objects to select them.



Polygon

Lets you create freeform drawings, which can be a combination of freehand shapes and straight lines.



Filled Rectangle

Draws filled rectangles or squares.



Filled Ellipse

Draws filled ellipses or circles.



Filled Arc

Draws filled arcs or circle segments.



Filled Polygon

Draws filled polygon shapes.



Filled Freeform

Draws filled freehand polygon shapes.



Color

Changes the color of the selected text each time you click the button. If you hold down SHIFT while clicking the 
button, the previous color is displayed.



Distribute Vertically

Distributes the selected objects vertically, relative to one another. Vertical distribution moves the selected objects 
so there is equal vertical distance between the edges of all the objects.



Select All Drawing Objects

Selects all the drawing objects in the active file.





Object (Insert menu)

Inserts an object ¾ such as a drawing, WordArt text effect, or an equation ¾ at the insertion point.



Snap To Grid

When Snap To Grid is turned on as you drag or draw an object or AutoShape, the object is pulled into alignment 
with the nearest intersection of gridlines on the invisible drawing grid



Size to Grid

Resizes the selected object to the boundaries of the invisible drawing grid.



Duplicate (Edit menu)

Makes a quick copy of a selected object. To make additional copies of the same object, click Duplicate again 
(Edit menu).





Align Left (Draw menu, Align or Distribute command)

Vertically aligns the left edges of the selected objects.



Align Right (Draw menu, Align or Distribute command)

Vertically aligns the right edges of the selected objects.



Align Top (Draw menu, Align or Distribute command)

Horizontally aligns the top edges of selected objects.



Align Bottom (Draw menu, Align or Distribute command)

Horizontally aligns the bottom edges of selected objects.



Align Center (Draw menu, Align or Distribute command)

Centers selected objects horizontally.



Align Middle (Draw menu, Align or Distribute command)

Vertically aligns the middles of selected objects.



Insert Clip Art

Opens the Clip Gallery where you can select the clip art image you want to insert in your file or update your clip 
art collection.



Microsoft Word

Sends your notes, handouts, or outline to Microsoft Word, where you can edit it by using Word commands. When
you work on an outline in Word, you can import it back into PowerPoint.



Shadow

Adds or removes a shadow from selected text.



Text Color

Changes the color of selected text.



Free Rotate

Rotates a selected object to any degree. Select the object, click the Free Rotate button, and then drag a corner 
of the object in the direction you want to rotate it.



AutoShapes

Inserts a shape where you click or drag in the active file. To draw a shape circumscribed within a perfect square, 
press SHIFT as you drag the shape.



Line Style

Click the style and thickness you want for the selected line.



Dash Style

Click the dashed line or dashed-dot line style you want for the selected shape or border. Click the solid line if you 
don't want a dashed line.



Arrow Style

Click the arrowhead style you want for the selected line.



Duplicate (Edit menu)

Makes a quick copy of a selected object. To make additional copies of the same object, click Duplicate Again.



This command is unavailable when you are editing a Microsoft Draw object.





Crop

Trims or restores portions of a picture. Click    , and then drag a sizing handle on the picture. 



TrueType Font

This is a TrueType font.



Printer Font

This font resides in the printer itself.



No Help Available

There is no help available for this command.



Save All (SHIFT+File menu)

Closes all open files in this application, prompting you to save any that have not yet been saved.



Save As (File menu)

Saves the active file with a different file name, location, or file format. In Microsoft Access, Microsoft Excel, and 
Word, you can also use this command to save a file with a password or to protect a file so that others cannot 
change its contents.



Properties (File menu)

Displays the property sheet for the active file.



Exit (File menu)

Closes this program after prompting you to save any unsaved files.



Copy As Picture

Copies a picture of the selected cell, cell range, or embedded chart.



Paste Special (Edit menu)

Pastes, links, or embeds the Clipboard contents in the current file in the format you specify.



Select All

Selects all text and graphics in the active window, or selects all text in the selected object.



Toolbars (View menu)

Displays or hides toolbars. To display a toolbar, select the check box next to the toolbar name. To hide a toolbar, 
clear the check box.



File (Insert menu)

Inserts all or part of the file you select, into the active file at the insertion point.



Paragraph (Format menu)

Changes paragraph indents, text alignment, line spacing, and other paragraph formats in the selected paragraph.



Bullet (Format menu)

Adds bullets to or removes bullets from selected paragraphs.



AutoShape (Format menu)

Formats the line, color, fill and pattern, size, position, and other properties of the selected object.



Toolbars Customize (View menu)

Customizes toolbar buttons, menu commands, and shortcut key assignments.



Exit With Restore Session

Closes this program after prompting you to save any unsaved files.



AutoFormat (Format menu)

Applies a built-in combination of formats, called an autoformat, to a cell range or a PivotTable. If a single cell is 
selected, Microsoft Excel automatically selects the range surrounded by blank cells and applies the autoformat to
that range. If the selection is part of a PivotTable, the entire table, except for the page fields, is selected and 
formatted. This command is not available if the sheet is protected.





Index (Help menu)

Displays the Help index for this Microsoft program.



Window List (Window menu)

Lists the currently open files in this program. Click the file you want to switch to.



Recently Used File List (File menu)

Lists the files you've most recently opened in this program. To quickly reopen one of these files, click it.



Minimize (Control menu)

Reduces a program or window to a button on the taskbar. To restore the window to its previous size and location,
click the button on the taskbar.



Restore (Control menu)

Restores a window to its previous size and location.



Close (Control menu)

Closes the active program or file. If an open file contains unsaved changes, you will be prompted to save the file 
before closing.



Move (Control menu)

Activates the arrow keys on the keyboard so you can change the location of the program or window by pressing 
the UP ARROW, DOWN ARROW, LEFT ARROW, or RIGHT ARROW key.



Size (Control menu)

Activates the arrow keys on the keyboard so you can change the size of the program or window by pressing the 
UP ARROW, DOWN ARROW, LEFT ARROW, or RIGHT ARROW key.



Maximize (Control menu)

Enlarges a program or window to fill the screen. To restore the window to its previous size and location, double-
click the title bar, or click Restore    .



Next Window

Activates the next open window in the program. A list of open windows is displayed at the bottom of the Window 
menu; the active window is checked.





OK

Applies and saves any changes you have made and then closes this dialog box.



Close

Closes this pane.



Close Picture

Closes the picture editor and returns to the previous editing mode.



Zoom (View menu)

Controls how large or small the current file appears on the screen.



About Microsoft Draw (Help menu)

Displays the version number of this Microsoft program and all applicable copyright, legal, and licensing notices.



Exchange Folder

Sends an active file to the Exchange Folder you specify.



Contents and Index (Help menu)

Opens the online Help index and table of contents for this Microsoft program.



Office Assistant (Help menu)

The Office Assistant provides Help topics and tips to help you accomplish your tasks.



Context Sensitive Help

Click        and then click a menu command or toolbar button to display online Help about the item.





More Colors

Opens the Colors dialog box, where you can pick a different color or mix your own custom color.



Fill Effects

Opens the Fill Effects dialog box, where you can pick a picture, gradient, textured, or patterned fill.



Pattern Fill

Opens the list of patterns you can use to fill the selected object.



More

If you don't see the item you want on the menu, click More to see the complete list of options.



Insert Graphic

Inserts a graphical object at the insertion point.



Insert Draw Server Object

Inserts a drawing server object at the insertion point.



WordArt

Creates text effects by inserting a Microsoft Office drawing object.



Reroute Connections

Updates the selected connections so the connector line attaches to the best connection site and takes the 
shortest route between the two shapes it connects (without crossing either shape).



Save to Clip Gallery

Saves the selected object in the Clip Gallery.



Nudge Up (Draw menu)

Moves the selected objects up in small increments ¾ one pixel at a time if Snap To Grid or Snap To Shape is 
turned off, or one grid point at a time if Snap To Grid or Snap To Shape is turned on.



Nudge Down (Draw menu)

Moves the selected objects down in small increments ¾ one pixel at a time if Snap To Grid or Snap To Shape is
turned off, or one grid point at a time if Snap To Grid or Snap To Shape is turned on.



Nudge Left (Draw menu)

Moves the selected objects left in small increments ¾ one pixel at a time if Snap To Grid or Snap To Shape is 
turned off, or one grid point at a time if Snap To Grid or Snap To Shape is turned on.



Nudge Right (Draw menu)

Moves the selected objects right in small increments ¾ one pixel at a time if Snap To Grid or Snap To Shape is 
turned off, or one grid point at a time if Snap To Grid or Snap To Shape is turned on.



Align or Distribute Relative to Page (Draw menu)

Aligns or distributes the selected objects relative to the page. Turn this option off (so no check mark appears next
to the command) if you want to align or distribute the selected objects relative to one another.



Curve

Inserts a line that curves smoothly through the points you click in the active window. Click where you want the 
shape to start, and then move the mouse, clicking wherever you want to add a curve. To end the shape and 
leave it open, double-click or press ESC. To close the shape, click near its starting point.



Straight Connector

Draws a straight connector line between the blue connection sites you click on two AutoShapes. Click the 
connection site on the first object, drag the connector to the second object, and then click a connection site.



Elbow Connector

Draws a 90-degree angled connector line between the blue connection sites you click on two AutoShapes. Click 
the connection site on the first object, drag the connector to the second object, and then click a connection site. 



Curved Connector

Draws a curved connector line between the blue connection sites you click on two AutoShapes. Click a 
connection site on the first object, drag the connector to the second object, and then click a connection site.



Callouts

Changes the currently selected AutoShape to the AutoShape you click on the Callouts menu.



Flowchart

Changes the currently selected AutoShape to the AutoShape you click on the Flowchart menu.



Block Arrows

Changes the currently selected AutoShape to the AutoShape you click on the Block Arrows menu.



Stars and Banners

Changes the currently selected AutoShape to the AutoShape you click on the Stars and Banners menu.



More Fill Colors

Displays additional fill colors.



More Line Colors

Displays additional line colors.



Pattern Fill

Displays patterns you can apply to the line of the selected object.



More Lines

Displays additional line styles and options.



More Arrows

Displays additional arrow shapes and options.



More Shadows

Displays the Shadow Settings toolbar, where you can apply additional shadow formatting.



3-D Settings

Displays the 3-D Settings toolbar, where you can apply additional 3-D formatting.



Text Shape

Changes the shape of the selected WordArt object.



WordArt Alignment

Displays the WordArt Alignment menu, where you can click the type of alignment you want for the selected 
WordArt object.



WordArt Character Spacing

Displays the WordArt Character Spacing menu, where you can apply kerning and increase or decrease the 
character spacing in the selected WordArt object.



WordArt Vertical Text

Stacks the text in the selected WordArt object vertically — one letter on top of the other — so you can read it 
from top to bottom.



Stretch to Fill

Scales the text in the selected object so it fills the entire object both horizontally and vertically.



WordArt Same Letter Heights

Makes all the letters in the current WordArt object the same height.



More Contrast

Increases the saturation, or intensity, of the colors in the selected picture. The higher the contrast, the less gray 
the color.



Less Contrast

Decreases the saturation, or intensity, of the colors in the selected picture. The lower the contrast, the more gray 
the color.



More Brightness

Adds white to lighten the colors in the selected picture. Brighter colors contain more white.



Less Brightness

Adds black to darken the colors in the selected picture. The lower the brightness, the darker (more black) the 
color.



Nudge Shadow Up

Moves the shadow of the selected object up by small increments.



Nudge Shadow Down

Moves the shadow of the selected object down by small increments.



Nudge Shadow Left

Moves the shadow of the selected object to the left by small increments.



Nudge Shadow Right

Moves the shadow of the selected object to the right by small increments.



More Shadow Colors

Displays additional colors for the shadow of the selected object.



More Colors

Displays additional colors for the 3-D effects on the selected object.



File (Insert menu)

Inserts a file in the item.





Left Align

Aligns the text to the left for the selected WordArt object.



Centered

Centers the text for the selected WordArt object.



Line Callout 4 (Border and Accent bar)

Draws a line callout with a border and an accent bar along the side of the callout text box. This line callout has 
four yellow adjustment handles. To add text to a callout, click the callout, and then type.



Rectangle

Draws a rectangle where you click or drag in the active window. To draw a square, hold down SHIFT and drag.



Parallelogram

Draws a parallelogram where you click or drag in the active window. To draw a parallelogram that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Trapezoid

Draws a trapezoid where you click or drag in the active window. To draw a trapezoid that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Diamond

Draws a diamond where you click or drag in the active window. To draw a diamond that retains its default height-
to-width ratio, hold down SHIFT and drag.



Rounded Rectangle

Draws a rounded rectangle where you click or drag in the active window. To draw a rounded square, hold down 
SHIFT and drag.



Octagon

Draws an octagon where you click or drag in the active window. To draw an octagon that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Isosceles Triangle

Draws an isosceles triangle where you click or drag in the active window. To draw an isosceles triangle that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Right Triangle

Draws a right triangle where you click or drag in the active window. To draw a right triangle that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Oval

Draws an oval where you click or drag in the active window. To draw a circle, hold down SHIFT and drag.



Hexagon

Draws a hexagon where you click or drag in the active window. To draw a hexagon that retains its default height-
to-width ratio, hold down SHIFT and drag.



Cross

Draws a cross where you click or drag in the active window. To draw a cross that retains its default height-to-
width ratio, hold down SHIFT and drag.



Cube

Draws a cube where you click or drag in the active window. To draw a cube that retains its default height-to-width
ratio, hold down SHIFT and drag.



Plaque

Draws a plaque where you click or drag in the active window. To draw a square plaque, hold down SHIFT and 
drag.



Regular Pentagon

Draws a pentagon where you click or drag in the active window. To draw a pentagon that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Wave

Draws a wave where you click or drag in the active window. To draw a wave that retains its default height-to-
width ratio, hold down SHIFT and drag.



Can

Draws a can where you click or drag in the active window. To draw a can that retains its default height-to-width 
ratio, hold down SHIFT and drag.



Vertical Scroll

Draws a vertical scroll where you click or drag in the active window. To draw a vertical scroll that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Horizontal Scroll

Draws a horizontal scroll where you click or drag in the active window. To draw a horizontal scroll that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Folded Corner

Draws a rectangle with a folded corner where you click or drag in the active window. To draw a square with a 
folded corner, hold down SHIFT and drag.



Bevel

Draws a beveled rectangle where you click or drag in the active window. To draw a beveled square, hold down 
SHIFT and drag.



Smiley Face

Draws a smiley face where you click or drag in the active window. To draw a smiley face that's a perfect circle, 
hold down SHIFT and drag.



Donut

Draws a donut where you click or drag in the active window. To draw a donut that's a perfect circle, hold down 
SHIFT and drag.



"No" Symbol

Draws a "No" symbol where you click or drag in the active window. To draw a "No" symbol that's a perfect circle, 
hold down SHIFT and drag.



Block Arc

Draws a block arc where you click or drag in the active window. To draw a block arc that retains its default height-
to-width ratio, hold down SHIFT and drag.



Left Bracket

Draws a left (open) bracket where you click or drag in the active window. To draw a left bracket that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Right Bracket

Draws a right (closed) bracket where you click or drag in the active window. To draw a right bracket that retains 
its default height-to-width ratio, hold down SHIFT and drag.



Left Brace

Draws a left brace where you click or drag in the active window. To draw a left brace that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Right Brace

Draws a right brace where you click or drag in the active window. To draw a right brace that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Arc

Draws an arc where you click or drag in the active window. To draw an arc that retains its default height-to-width 
ratio, hold down SHIFT and drag.



Lightning Bolt

Draws a lightning bolt where you click or drag in the active window. To draw a lightning bolt that retains its default
height-to-width ratio, hold down SHIFT and drag.



Heart

Draws a heart where you click or drag in the active window. To draw a heart that retains its default height-to-width
ratio, hold down SHIFT and drag.



Right Arrow

Draws a right arrow where you click or drag in the active window. To draw a right arrow that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Left Arrow

Draws a left arrow where you click or drag in the active window. To draw a left arrow that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Up Arrow

Draws an up arrow where you click or drag in the active window. To draw an up arrow that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Down Arrow

Draws a down arrow where you click or drag in the active window. To draw a down arrow that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Left-Right Arrow

Draws a left-right arrow where you click or drag in the active window. To draw a left-right arrow that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Up-Down Arrow

Draws an up-down arrow where you click or drag in the active window. To draw an up-down arrow that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Quad Arrow

Draws a four-headed arrow where you click or drag in the active window. To draw a four-headed arrow that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Left-Right-Up Arrow

Draws a three-headed arrow where you click or drag in the active window. To draw a three-headed arrow that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Left-Up Arrow

Draws a two-headed arrow where you click or drag in the active window. To draw a two-headed arrow that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Bent-Up Arrow

Draws a bent-up arrow where you click or drag in the active window. To draw a bent-up arrow that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Bent Arrow

Draws a bent arrow where you click or drag in the active window. To draw a bent arrow that retains its default 
height-to-width ratio, hold down SHIFT and drag.



U-Turn Arrow

Draws a U-Turn arrow where you click or drag in the active window. To draw a U-Turn arrow that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Striped Right Arrow

Draws a striped right arrow where you click or drag in the active window. To draw a striped right arrow that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Notched Right Arrow

Draws a notched right arrow where you click or drag in the active window. To draw a notched right arrow that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Pentagon

Draws a right pentagon arrow where you click or drag in the active window. To draw a right pentagon arrow that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Chevron

Draws a right-pointing chevron where you click or drag in the active window. To draw a right-pointing chevron that
retains its default height-to-width ratio, hold down SHIFT and drag.



Circular Arrow

Draws a circular arrow where you click or drag in the active window. To draw a circular arrow that's a perfect 
circle, hold down SHIFT and drag.



Notched Circular Arrow

Draws a notched circular arrow where you click or drag in the active window. To draw a notched circular arrow 
that's a perfect circle, hold down SHIFT and drag.



Curved Right Arrow

Draws a curved right arrow where you click or drag in the active window. To draw a curved right arrow that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Curved Left Arrow

Draws a curved left arrow where you click or drag in the active window. To draw a curved left arrow that retains 
its default height-to-width ratio, hold down SHIFT and drag.



Curved Up Arrow

Draws a curved up arrow where you click or drag in the active window. To draw a curved up arrow that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Curved Down Arrow

Draws a curved down arrow where you click or drag in the active window. To draw a curved down arrow that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Right Arrow Callout

Draws a right arrow callout where you click or drag in the active window. To draw a right arrow callout that retains
its default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and then 
type.



Left Arrow Callout

Draws a left arrow callout where you click or drag in the active window. To draw a left arrow callout that retains its
default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and then type.



Up Arrow Callout

Draws an up arrow callout where you click or drag in the active window. To draw an up arrow callout that retains 
its default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and then 
type.



Down Arrow Callout

Draws a down arrow callout where you click or drag in the active window. To draw a down arrow callout that 
retains its default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and 
then type.



Left-Right Arrow Callout

Draws a left-right arrow callout where you click or drag in the active window. To draw a left-right arrow callout that
retains its default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and 
then type.



Up-Down Arrow Callout

Draws an up-down arrow callout where you click or drag in the active window. To draw an up-down arrow callout 
that retains its default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, 
and then type.



Quad Arrow Callout

Draws a four-headed arrow callout where you click or drag in the active window. To draw a four-headed arrow 
callout that retains its default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the 
callout, and then type.



Balloon

Draws a balloon callout where you click or drag in the active window. To draw a balloon callout that retains its 
default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and then type.



Rectangular Callout

Draws a rectangular callout where you click or drag in the active window. To draw a rectangular callout that 
retains its default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and 
then type.



Rounded Rectangular Callout

Draws a rounded rectangular callout where you click or drag in the active window. To draw a rounded rectangular
callout that retains its default height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the 
callout, and then type.



Oval Callout

Draws an oval callout where you click or drag in the active window. To draw an oval callout that retains its default 
height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and then type.



Cloud Callout

Draws a cloud callout where you click or drag in the active window. To draw a cloud callout that retains its default 
height-to-width ratio, hold down SHIFT and drag. To add text to a callout, click the callout, and then type.



Line Callout 2

Draws a line callout with a border but no accent bar. This line callout has two yellow adjustment handles. To add 
text to a callout, click the callout, and then type.



Line Callout 3

Draws a line callout with a border but no accent bar. This line callout has three yellow adjustment handles. To 
add text to a callout, click the callout, and then type.



Line Callout 4

Draws a line callout with a border but no accent bar. This line callout has four yellow adjustment handles. To add 
text to a callout, click the callout, and then type.



Down Ribbon

Draws a down ribbon where you click or drag in the active window. To draw a down ribbon that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Up Ribbon

Draws an up ribbon where you click or drag in the active window. To draw an up ribbon that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Curved Down Ribbon

Draws a curved down ribbon where you click or drag in the active window. To draw a curved down ribbon that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Curved Up Ribbon

Draws a curved up ribbon where you click or drag in the active window. To draw a curved up ribbon that retains 
its default height-to-width ratio, hold down SHIFT and drag.



5-Point Star

Draws a 5-point star where you click or drag in the active window. To draw a 5-point star that retains its default 
height-to-width ratio, hold down SHIFT and drag.



8-Point Star

Draws an 8-point star where you click or drag in the active window. To draw an 8-point star that retains its default 
height-to-width ratio, hold down SHIFT and drag.



16-Point Star

Draws a 16-point star where you click or drag in the active window. To draw a 16-point star that retains its default 
height-to-width ratio, hold down SHIFT and drag.



24-Point Star

Draws a 24-point star where you click or drag in the active window. To draw a 24-point star that retains its default 
height-to-width ratio, hold down SHIFT and drag.



32-Point Star

Draws a 32-point star where you click or drag in the active window. To draw a 32-point star that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Explosion 1

Draws an explosion where you click or drag in the active window. To draw an explosion that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Explosion 2

Draws an explosion where you click or drag in the active window. To draw an explosion that retains its default 
height-to-width ratio, hold down SHIFT and drag.



Flowchart: Process

Draws a process flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Alternate Process

Draws an alternate process flowchart symbol where you click or drag in the active window. To draw a symbol that
retains its default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Decision

Draws a decision flowchart symbol where you click or drag in the active window. To draw a symbol that retains its
default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Data

Draws a data flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Predefined Process

Draws a predefined process flowchart symbol where you click or drag in the active window. To draw a symbol 
that retains its default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Internal Storage

Draws an internal storage flowchart symbol where you click or drag in the active window. To draw a symbol that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Document

Draws a document flowchart symbol where you click or drag in the active window. To draw a symbol that retains 
its default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Multidocument

Draws a multidocument flowchart symbol where you click or drag in the active window. To draw a symbol that 
retains its default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Terminator

Draws a terminator flowchart symbol where you click or drag in the active window. To draw a symbol that retains 
its default height-to-width ratio, hold down SHIFT and drag.



Flowchart: Preparation

Draws a preparation flowchart symbol where you click or drag in the active window. To draw a symbol that retains
its default height-to-width ratio, hold down SHIFT and drag.





Flowchart: Manual Input

Draws a manual input flowchart symbol where you click or drag in the active window. To draw a symbol that 
retains its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Manual Operation

Draws a manual operation flowchart symbol where you click or drag in the active window. To draw a symbol that 
retains its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Connector

Draws a connector flowchart symbol where you click or drag in the active window. To draw a symbol that retains 
its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Off-Page Connector

Draws an off-page connector flowchart symbol where you click or drag in the active window. To draw a symbol 
that retains its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Card

Draws a card flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Punched Tape

Draws a punched tape flowchart symbol where you click or drag in the active window. To draw a symbol that 
retains its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Summing Junction

Draws a summing junction flowchart symbol where you click or drag in the active window. To draw a symbol that 
retains its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: OR

Draws an OR flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Collate

Draws a collate flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Sort

Draws a sort flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Extract

Draws an extract flowchart symbol where you click or drag in the active window. To draw a symbol that retains its
default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Merge

Draws a merge flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Offline

Draws an offline flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Stored Data

Draws a stored data flowchart symbol where you click or drag in the active window. To draw a symbol that retains
its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Sequential Access Storage

Draws a sequential access storage flowchart symbol where you click or drag in the active window. To draw a 
symbol that retains its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Magnetic Disk

Draws a magnetic disk access flowchart symbol where you click or drag in the active window. To draw a symbol 
that retains its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Direct Access Storage

Draws a direct access storage flowchart symbol where you click or drag in the active window. To draw a symbol 
that retains its default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Display

Draws a display flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Flowchart: Delay

Draws a delay flowchart symbol where you click or drag in the active window. To draw a symbol that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Line Callout 1

Draws a line callout with a border but no accent bar. This callout line has one segment and two yellow 
adjustment handles, and it attaches to a corner of the callout text box. To add text to a callout, click the callout, 
and then type.



Line Callout 1 (Accent Bar)

Draws a line callout with an accent bar along the side of the callout text box (no border). This callout line has one
segment and two yellow adjustment handles, and it attaches to a corner of the callout text box. To add text to a 
callout, click the callout, and then type.



Line Callout 2 (Accent Bar)

Draws a line callout with an accent bar along the side of the callout text box (no border). This callout line has one
segment and two yellow adjustment handles. To add text to a callout, click the callout, and then type.



Line Callout 3 (Accent Bar)

Draws a line callout with an accent bar along the side of the callout text box (no border). This callout line has two 
segments and three yellow adjustment handles. To add text to a callout, click the callout, and then type.



Line Callout 4 (Accent Bar)

Draws a line callout with an accent bar along the side of the callout text box (no border). This callout line has 
three segments and four yellow adjustment handles. To add text to a callout, click the callout, and then type.



Line Callout 1 (No Border)

Draws a line callout with neither a border nor an accent bar. This callout line has one segment and two yellow 
adjustment handles, and it attaches to a corner of the callout text box. To add text to a callout, click the callout, 
and then type.



Line Callout 2 (No Border)

Draws a line callout with neither a border nor an accent bar. This callout line has one segment and two yellow 
adjustment handles. To add text to a callout, click the callout, and then type.



Line Callout 3 (No Border)

Draws a line callout with neither a border nor an accent bar. This callout line has two segments and three yellow 
adjustment handles. To add text to a callout, click the callout, and then type.



Line Callout 4 (No Border)

Draws a line callout with neither a border nor an accent bar. This callout line has three segments and four yellow 
adjustment handles. To add text to a callout, click the callout, and then type.



Line Callout 1 (Border and Accent Bar)

Draws a line callout with a border and an accent bar along the side of the callout text box. This callout line has 
one segment and two yellow adjustment handles, and it attaches to a corner of the callout text box. To add text to
a callout, click the callout, and then type.



Line Callout 2 (Border and Accent Bar)

Draws a line callout with a border and an accent bar along the side of the callout text box. This callout line has 
one segment and two yellow adjustment handles. To add text to a callout, click the callout, and then type.



Line Callout 3 (Border and Accent Bar)

Draws a line callout with a border and an accent bar along the side of the callout text box. This callout line has 
two segments and three yellow adjustment handles. To add text to a callout, click the callout, and then type.



Change AutoShape to Line Callout 4 (Border and Accent Bar)

Changes the selected AutoShape to a line callout 4. To add text to a callout, click the callout, and then type.



Change AutoShape to Rectangle

Changes the selected AutoShape to a rectangle.



Change AutoShape to Parallelogram

Changes the selected AutoShape to a parallelogram.



Change AutoShape to Trapezoid

Changes the selected AutoShape to a trapezoid.



Change AutoShape to Diamond

Changes the selected AutoShape to a diamond.



Change AutoShape to Rounded Rectangle

Changes the selected AutoShape to a rounded rectangle.



Change AutoShape to Octagon

Changes the selected AutoShape to an octagon.



Change AutoShape to Isosceles Triangle

Changes the selected AutoShape to an isosceles triangle.



Change AutoShape to Right Triangle

Changes the selected AutoShape to a right triangle.



Change AutoShape to Oval

Changes the selected AutoShape to an oval.



Change AutoShape to Hexagon

Changes the selected AutoShape to a hexagon.



Change AutoShape to Cross

Changes the selected AutoShape to a cross.



Change AutoShape to Cube

Changes the selected AutoShape to a cube.



Change AutoShape to Plaque

Changes the selected AutoShape to a plaque.



Change AutoShape to Regular Pentagon

Changes the selected AutoShape to a regular pentagon



Change AutoShape to Wave

Changes the selected AutoShape to a wave.



Change AutoShape to Can

Changes the selected AutoShape to a can.



Change AutoShape to Vertical Scroll

Changes the selected AutoShape to a vertical scroll.



Change AutoShape to Horizontal Scroll

Changes the selected AutoShape to a horizontal scroll.



Change AutoShape to Folded Corner

Changes the selected AutoShape to a rectangle with a folded corner.



Change AutoShape to Bevel

Changes the selected AutoShape to a beveled rectangle.



Change AutoShape to Smiley Face

Changes the selected AutoShape to a smiley face.



Change AutoShape to Donut

Changes the selected AutoShape to a donut.



Change AutoShape to "No" Symbol

Changes the selected AutoShape to a "No" symbol.



Change AutoShape to Block Arc

Changes the selected AutoShape to a block arc.



Change AutoShape to Left Bracket

Changes the selected AutoShape to a left bracket.



Change AutoShape to Right Bracket

Changes the selected AutoShape to a right bracket.



Change AutoShape to Left Brace

Changes the selected AutoShape to a left brace.



Change AutoShape to Right Brace

Changes the selected AutoShape to a right brace.



Change AutoShape to Arc

Changes the selected AutoShape to an arc.



Change AutoShape to Lightning Bolt

Changes the selected AutoShape to a lightning bolt.



Change AutoShape to Heart

Changes the selected AutoShape to a heart.



Change AutoShape to Right Arrow

Changes the selected AutoShape to a right arrow.



Change AutoShape to Left Arrow

Changes the selected AutoShape to a left arrow.



Change AutoShape to Up Arrow

Changes the selected AutoShape to an up arrow.



Change AutoShape to Down Arrow

Changes the selected AutoShape to a down arrow.



Change AutoShape to Left-Right Arrow

Changes the selected AutoShape to a left-right arrow.



Change AutoShape to Up-Down Arrow

Changes the selected AutoShape to an up-down arrow.



Change AutoShape to Quad Arrow

Changes the selected AutoShape to a four-headed arrow.



Change AutoShape to Left-Right-Up Arrow

Changes the selected AutoShape to a three-headed arrow.



Change AutoShape to Left-Up Arrow

Changes the selected AutoShape to a left-up arrow.



Change AutoShape to Bent-Up Arrow

Changes the selected AutoShape to a bent-up arrow.



Change AutoShape to Bent Arrow

Changes the selected AutoShape to a bent arrow.



Change AutoShape to U-Turn Arrow

Changes the selected AutoShape to a U-Turn arrow.



Change AutoShape to Striped Right Arrow

Changes the selected AutoShape to a striped right arrow.



Change AutoShape to Notched Right Arrow

Changes the selected AutoShape to a notched right arrow.



Change AutoShape to Pentagon

Changes the selected AutoShape to a right pentagon arrow.



Change AutoShape to Chevron

Changes the selected AutoShape to a right chevron arrow.



Change AutoShape to Circular Arrow

Changes the selected AutoShape to a circular arrow.



Change AutoShape to Notched Circular Arrow

Changes the selected AutoShape to a notched circular arrow.



Change AutoShape to Curved Right Arrow

Changes the selected AutoShape to a curved right arrow.



Change AutoShape to Curved Left Arrow

Changes the selected AutoShape to a curved left arrow.



Change AutoShape to Curved Up Arrow

Changes the selected AutoShape to a curved up arrow



Change AutoShape to Curved Down Arrow

Changes the selected AutoShape to a curved down arrow.



Change AutoShape to Right Arrow Callout

Changes the selected AutoShape to a right arrow callout. To add text to a callout, click the callout, and then type.



Change AutoShape to Left Arrow Callout

Changes the selected AutoShape to a left arrow callout. To add text to a callout, click the callout, and then type.



Change AutoShape to Up Arrow Callout

Changes the selected AutoShape to an up arrow callout. To add text to a callout, click the callout, and then type.



Change AutoShape to Down Arrow Callout

Changes the selected AutoShape to a down arrow callout. To add text to a callout, click the callout, and then 
type.



Change AutoShape to Left-Right Arrow Callout

Changes the selected AutoShape to a left-right arrow callout. To add text to a callout, click the callout, and then 
type.



Change AutoShape to Up-Down Arrow Callout

Changes the selected AutoShape to an up-down arrow callout. To add text to a callout, click the callout, and then 
type.



Change AutoShape to Quad Arrow Callout

Changes the selected AutoShape to a four-headed arrow callout. To add text to a callout, click the callout, and 
then type.



Change AutoShape to Balloon

Changes the selected AutoShape to a balloon.



Change AutoShape to Rectangular Callout

Changes the selected AutoShape to a rectangular callout. To add text to a callout, click the callout, and then type.



Change AutoShape to Rounded Rectangular Callout

Changes the selected AutoShape to a rounded rectangular callout. To add text to a callout, click the callout, and 
then type.



Change AutoShape to Oval Callout

Changes the selected AutoShape to an oval callout. To add text to a callout, click the callout, and then type.



Change AutoShape to Cloud Callout

Changes the selected AutoShape to a cloud callout. To add text to a callout, click the callout, and then type.



Change AutoShape to Line Callout 2

Changes the selected AutoShape to a line callout 2. To add text to a callout, click the callout, and then type.



Change AutoShape to Line Callout 3

Changes the selected AutoShape to a line callout 3. To add text to a callout, click the callout, and then type.



Change AutoShape to Line Callout 4

Changes the selected AutoShape to a line callout 4. To add text to a callout, click the callout, and then type.





Change AutoShape to Down Ribbon

Changes the selected AutoShape to a down ribbon.



Change AutoShape to Up Ribbon

Changes the selected AutoShape to an up ribbon.



Change AutoShape to Curved Down Ribbon

Changes the selected AutoShape to a curved down ribbon.



Change AutoShape to Curved Up Ribbon

Changes the selected AutoShape to a curved up ribbon.



Change AutoShape to 5-Point Star

Changes the selected AutoShape to a 5-point star.



Change AutoShape to 8-Point Star

Changes the selected AutoShape to an 8-point star.



Change AutoShape to 16-Point Star

Changes the selected AutoShape to a 16-point star.



Change AutoShape to 24-Point Star

Changes the selected AutoShape to a 24-point star.



Change AutoShape to 32-Point Star

Changes the selected AutoShape to a 32-point star.



Change AutoShape to Explosion 1

Changes the selected AutoShape to an explosion shape.



Change AutoShape to Explosion 2

Changes the selected AutoShape to an explosion shape.



Change AutoShape to Flowchart: Process

Changes the selected AutoShape to a process flowchart symbol.



Change AutoShape to Flowchart: Alternate Process

Changes the selected AutoShape to an alternate process flowchart symbol.



Change AutoShape to Flowchart: Decision

Changes the selected AutoShape to a decision flowchart symbol.



Change AutoShape to Flowchart: Data

Changes the selected AutoShape to a data flowchart symbol.



Change AutoShape to Flowchart: Predefined Process

Changes the selected AutoShape to a predefined process flowchart symbol.



Change AutoShape to Flowchart: Internal Storage

Changes the selected AutoShape to an internal storage flowchart symbol.



Change AutoShape to Flowchart: Document

Changes the selected AutoShape to a document flowchart symbol.



Change AutoShape to Flowchart: Multidocument

Changes the selected AutoShape to a multidocument flowchart symbol.



Change AutoShape to Flowchart: Terminator

Changes the selected AutoShape to a terminator flowchart symbol.



Change AutoShape to Flowchart: Preparation

Changes the selected AutoShape to a preparation flowchart symbol.



Change AutoShape to Flowchart: Manual Input

Changes the selected AutoShape to a manual input flowchart symbol.



Change AutoShape to Flowchart: Manual Operation

Changes the selected AutoShape to a manual operation flowchart symbol.



Change AutoShape to Flowchart: Connector

Changes the selected AutoShape to a connector flowchart symbol.



Change AutoShape to Flowchart: Off-Page Connector

Changes the selected AutoShape to an off-page connector flowchart symbol.



Change AutoShape to Flowchart: Card

Changes the selected AutoShape to a card flowchart symbol.



Change AutoShape to Flowchart: Punched Tape

Changes the selected AutoShape to a punched tape flowchart symbol.



Change AutoShape to Flowchart: Summing Junction

Changes the selected AutoShape to a summing junction flowchart symbol.



Change AutoShape to Flowchart: OR

Changes the selected AutoShape to an OR flowchart symbol.



Change AutoShape to Flowchart: Collate

Changes the selected AutoShape to a collate flowchart symbol.



Change AutoShape to Flowchart: Sort

Changes the selected AutoShape to a sort flowchart symbol.



Change AutoShape to Flowchart: Extract

Changes the selected AutoShape to an extract flowchart symbol.



Change AutoShape to Flowchart: Merge

Changes the selected AutoShape to a merge flowchart symbol.



Change AutoShape to Flowchart: Offline Storage

Changes the selected AutoShape to an offline storage flowchart symbol.



Change AutoShape to Flowchart: Stored Data

Changes the selected AutoShape to a stored data flowchart symbol.



Change AutoShape to Flowchart: Sequential Access Storage

Changes the selected AutoShape to a sequential access storage flowchart symbol.



Change AutoShape to Flowchart: Magnetic Disk

Changes the selected AutoShape to a magnetic disk flowchart symbol.



Change AutoShape to Flowchart: Direct Access Storage

Changes the selected AutoShape to a direct access storage flowchart symbol.



Change AutoShape to Flowchart: Display

Changes the selected AutoShape to a display flowchart symbol.



Change AutoShape to Flowchart: Delay

Changes the selected AutoShape to a delay flowchart symbol.



Change AutoShape to Line Callout 1

Changes the selected AutoShape to a line callout 1. To add text to a callout, click the callout, and then type.



Change AutoShape to Line Callout 1 (Accent Bar)

Changes the selected AutoShape to a line callout 1 with an accent bar but no border. To add text to a callout, 
click the callout, and then type.



Change AutoShape to Line Callout 2 (Accent Bar)

Changes the selected AutoShape to a line callout 2 with an accent bar but no border. To add text to a callout, 
click the callout, and then type.



Change AutoShape to Line Callout 3 (Accent Bar)

Changes the selected AutoShape to a line callout 3 with an accent bar but no border. To add text to a callout, 
click the callout, and then type.



Change AutoShape to Line Callout 4 (Accent Bar)

Changes the selected AutoShape to a line callout 4 with an accent bar but no border. To add text to a callout, 
click the callout, and then type.



Change AutoShape to Line Callout 1 (No Border)

Changes the selected AutoShape to a line callout 1 with neither an accent bar nor a border. To add text to a 
callout, click the callout, and then type.



Change AutoShape to Line Callout 2 (No Border)

Changes the selected AutoShape to a line callout 2 with neither an accent bar nor a border. To add text to a 
callout, click the callout, and then type.



Change AutoShape to Line Callout 3 (No Border)

Changes the selected AutoShape to a line callout 3 with neither an accent bar nor a border. To add text to a 
callout, click the callout, and then type.



Change AutoShape to Line Callout 4 (No Border)

Changes the selected AutoShape to a line callout 4 with neither an accent bar nor a border. To add text to a 
callout, click the callout, and then type.



Change AutoShape to Line Callout 1 (Border and Accent Bar)

Changes the selected AutoShape to a line callout 1 with a border and an accent bar. To add text to a callout, click
the callout, and then type.



Change AutoShape to Line Callout 2 (Border and Accent Bar)

Changes the selected AutoShape to a line callout 2 with a border and an accent bar. To add text to a callout, click
the callout, and then type.



Change AutoShape to Line Callout 3 (Border and Accent Bar)

Changes the selected AutoShape to a line callout 3 with a border and an accent bar. To add text to a callout, click
the callout, and then type.



Right Align

Aligns the selected text effect to the right with a ragged left edge.



Letter Justify

Aligns or justifies the selected text effect at both the left and right edges by distributing space between individual 
letters as well as words.



    Word Justify
Aligns or justifies the selected text effect at both the left and right edges by distributing space between each word but 
not between individual letters in each word. If your text effect has only one letter, letter justification is applied.



Stretch Justify

Aligns or justifies the selected text effect at both the left and right edges by scaling the text horizontally. No space
is added between individual letters or words.



Very Tight

Places the characters in your text effect very close together. This is the most compact character-spacing setting.



Tight

Places the characters in your text effect close together. Click Very Tight to place the characters closer together, 
or click Normal to place them farther apart.



Normal

Applies normal character spacing to your text effect. 



Loose

Adds extra space between the characters in your text effect. Click Normal to place the characters closer 
together, or click Very Loose to place them farther apart.



Very Loose

Adds the maximum amount of space between the characters in your text effect. This is the least compact 
character-spacing setting.



Kern Character Pairs

Automatically adjusts kerning, or the amount of space between certain combinations of characters, so that the 
entire word looks more evenly spaced. Kerning works only with TrueType or Adobe Type Manager fonts.



Reset Picture

Removes cropping from the selected picture and returns the color, brightness, and contrast to the original 
settings.



Inline Picture

Places the selected picture inline, in the current paragraph, where it behaves like regular text.



Recolor Picture/Chart/Organization Chart

Opens the Recolor dialog box, in which you can change the colors of the selected picture, chart, or organization 
chart.



Automatic

When you insert a picture, it automatically assumes the most appropriate format. To change the image type, click
one of the other formats.



Grayscale

Converts the selected picture to a grayscale image, which means each color is changed to an equivalent shade 
of gray.



Black and White

Converts the selected picture to a black and white image, also known as line art.



Watermark

Converts the selected picture to a bright, low-contrast picture that you can place behind everything else on the 
page using the Order commands (Drawing toolbar, Draw menu).



Square Wrapping

Wraps text around all sides of the square bounding box for the selected object.



Tight Wrapping

Wraps text around the perimeter of the selected object. To change the perimeter, click Edit Wrap Points        
on the Picture toolbar.



No Wrapping

Removes all text-wrapping formatting so that text does not wrap around the selected object. If you want the 
object to appear behind or in front of text, click Order on the Draw menu, and then click the order you want. 



Edit Wrap Points

Displays the vertexes so you can change the text-wrapping perimeter around the selected object. To reshape the

perimeter, drag one of the vertexes. Text wraps to this perimeter when you apply Tight        or Through    

    text wrapping.



3-D On/Off

Turns on 3-D formatting for the selected object using the default 3-D settings, or turns off 3-D formatting. 3-D and
shadow formatting are mutually exclusive — if you turn on 3-D formatting, any shadow settings are automatically 
turned off, and vice versa.



Tilt Down

Rotates the 3-D effect 6 degrees around a horizontal axis. To rotate the 3-D to the next 45-degree point, hold 

down SHIFT and click    .



Tilt Up

Rotates the 3-D effect 6 degrees around a horizontal axis. To rotate the 3-D to the next 45-degree point, hold 

down SHIFT and click    .



Tilt Left

Rotates the 3-D effect 6 degrees to the left around a vertical axis. To rotate the 3-D to the next 45-degree point, 

hold down SHIFT and click    .



Tilt Right

Rotates the 3-D effect 6 degrees to the right around a vertical axis. To rotate the 3-D to the next 45-degree point, 

hold down SHIFT and click    .



Depth Menu

Sets how deep the 3-D effect extends on the selected object.



Direction Menu

Sets the direction the 3-D effect extends on the selected object.



Lighting Menu

Sets the direction from which light shines on the selected 3-D object.



Surface Menu

Sets the shininess and reflective properties of the surface of the selected object.



0 pt.

Sets the depth of the 3-D effect on the selected object to zero.



36 pt.

Sets the depth of the 3-D effect on the selected object to 36 point (or .5 inches).



72 pt.

Sets the depth of the 3-D effect on the selected object to 72 points (or 1 inch).



144 pt.

Sets the depth of the 3-D effect on the selected object to 144 point (or 2 inches).



288 pt.

Sets the depth of the 3-D effect on the selected object to 288 point (or 4 inches).



Infinity

Makes the 3-D effect look like it extends indefinitely.



Perspective

Makes the 3-D effect extend toward a single point, so it looks like you are viewing the objects from a single 
location. Perspective projection looks more "real," but it may make similar 3-D effects look different on adjacent 
objects.



Parallel

Extends all sides of the 3-D effect parallel to one another instead of toward a single "viewing" point. Parallel 
projection makes the 3-D effect look consistent across multiple objects. This effect (also known as isometric or 
cabinet projection) is often used for technical drawings.



Bright

Bright lighting adds the most white to the color or shade of the 3-D effect on the selected object.



Normal

Normal lighting adds a moderate amount of white to the color or shade of the 3-D effect on the selected object.



Dim

Dim lighting adds the least amount of white to the color or shade of the 3-D effect on the selected object.



Matte

Makes the surface of the selected object look unreflective or dull.



Plastic

Makes the surface of the selected object look like plastic.



Dull Metal

Makes the surface of the selected object look like unpolished metal.



Metal

Makes the surface of the selected object look like polished metal.



Wire Frame

Removes all the surfaces from the selected object and displays only the underlying structure.





Add Text

Switches to text-editing mode so you can add text to the selected AutoShape.



Edit Text

Switches to text-editing mode so you can edit the text in the selected AutoShape.



To Shape

Automatically aligns objects with gridlines that go through the vertical and horizontal edges of other shapes in the
active file.



Image Control

Click the image type you want for the selected picture.



Text Wrapping

Click the text wrapping style you want for the selected object. To set additional text wrapping options, click 
Object on the Format menu, and then click the Wrapping tab.



Basic Shapes

Changes the selected AutoShape to the AutoShape you click on the Basic Shapes menu.



Block Arrows

Changes the selected AutoShape to the AutoShape you click on the Block Arrows menu.



Flowchart

Changes the selected AutoShape to the AutoShape you click on the Flowchart menu.



Stars and Banners

Changes the selected AutoShape to the AutoShape you click on the Stars and Banners menu.



Callouts Menu

Changes the selected AutoShape to the AutoShape you click on the Callouts menu.



Show WordArt Toolbar

Opens the WordArt toolbar.



Hide WordArt Toolbar

Closes the WordArt toolbar.



Exit Rotate

Turns off the Free Rotate tool (Drawing toolbar).



Show/Hide Picture Toolbar

Opens or hides the Picture toolbar.



Hide Picture Toolbar

Closes the Picture toolbar.



Add Point

Adds a new vertex to the curved line at the point you right-clicked.



Delete Point

Removes the selected vertex from the curved line and reconnects the line between the two adjacent vertices.



Straight Segment

Changes the selected segment to a straight segment.



Curved Segment

Changes the selected segment to a curved segment.



Auto Point

Tangent lines are calculated automatically, and no tangent points or lines are visible. The result is a smoothly 
curved segment that passes through this point.



Smooth Point

Both tangent points are always the same distance from the original point, and are always 180 degrees apart.



Straight Point

Tangent lines maintain their 180-degree angle, but the length of each can change independently.



Corner Point

The length and angle between the two tangent lines are independent. You can only select one point at a time, 
and you can change the property of each point.



Exit Edit Point

Turns off the point- and property-editing mode for curves.



Close Curve

Completes an open curve by adding a segment that connects the first and last points.



Canvas Size

Sets the size of the rectangle in which the drawing appears.



Remove Split

Removes the split from the active window.



Edit Routing Slip (File menu)

Opens the online routing slip for the active document. To use routing, you and recipients of the document must 
have installed both the program the document is created in and Microsoft Exchange or a compatible e-mail 
system.



Save and Update All

Saves the active file and all its embedded objects with their current file names, locations, and file formats.



Save Copy As

Saves a copy of the active file with a different file name.



Save Template

Saves the template that is attached to the active file.



Resume Recording

Resumes recording a macro after you click Pause        to suspend recording. 



Arrange Icons (Window menu)

Aligns all the minimized documents so their title bars do not overlap on the Word screen.



Paste Rows (Edit menu)

Inserts the table rows from the Clipboard at the insertion point. Make sure the area you paste into has the same 
number of rows and columns as the area you cut or copy. If you paste plain text into a table, make sure you 
select only one table cell.



Paste Columns (Edit menu)

Inserts the table columns from the Clipboard at the insertion point. Make sure the area you paste into has the 
same number of rows and columns as the area you cut or copy. If you paste plain text into a table, make sure 
you select only one table cell.



Paste Cells (Edit menu)

Inserts the table cells from the Clipboard at the insertion point. Make sure the area you paste into has the same 
number of rows and columns as the area you cut or copy. If you paste plain text into a table, make sure you 
select only one table cell.



Unprotect Document (Tools menu)

Removes protection from an online form or document. If the document is protected with a password, you must 
type the password with uppercase and lowercase letters exactly as you originally typed to remove protection.



Format Frame

Formats the selected frame.



Open History Folder

Shows additional hyperlinks you used recently.



History

Shows hyperlinks you used recently.



Favorites

Shows the contents of the Favorites folder.



URL

Click this hyperlink to go to the destination.



Print Preview

Shows how a document will look when you print it.



Text Envelopes

Click the type of envelope you want.



Shadow Styles

Click the shadow style you want for the selected object.



3-D Styles

Click the 3-D style you want for the selected object.



Custom Icons

Click the icon you want to assign to the selected item.



No Fill

Removes the fill from the selected object.



Automatic Color

Fills the selected object with the fill color for the active color scheme. To see which color is the fill color, point to 
each color on this menu until its ScreenTip appears.



Color Scheme

Click the color you want to use to fill the selected object.



Standard Colors

Click the fill color you want, or click More Fill Colors and then pick a different color.



Recently Used Colors

These are the nonstandard fill colors you most recently used. Click a color here to quickly use it again.



No Line

Removes the line from the selected object.



Automatic Color

Changes the line color of the selected object to the Text and Line Color for the active color scheme. To see which
color is the Text and Line Color, point to each color on this menu until its ScreenTip appears.



Color Scheme

Click the line color you want for the selected object.



Standard Colors

Click the line color you want, or click More Line Colors and then pick a different color.



Recently Used Colors

These are the nonstandard line colors you most recently used. Click a color here to quickly use it again.



No Shadow

Removes the shadow from the selected object.



Automatic Color

Changes the selected shadow to the Shadow Color for the active color scheme. To see which color is the 
Shadow Color, point to each color on this menu until its ScreenTip appears.



Color Scheme

Click the shadow color you want for the selected object.



Standard Colors

Click the shadow color you want, or click More Shadow Colors and then pick a different color.



Recently Used Colors

These are the nonstandard shadow colors you most recently used. Click a color here to quickly use it again.



No 3-D

Removes the 3-D effect from the selected object.



Automatic Color

Changes the selected 3-D effect to the Shadow Color for the active color scheme. To see which color is the 
Shadow Color, point to each color on this menu until its ScreenTip appears.



Color Scheme

Click the 3-D color you want for the selected object.



Standard Colors

Click the 3-D color you want, or click More 3-D Colors and then pick a different color.



Recently Used Colors

These are the nonstandard 3-D colors you most recently used. Click a color here to quickly use it again.



Lighting Direction

Click the direction from which you want light to shine on the selected 3-D object. Point to a lighting button, and 
then look at the cube in the center to see a sample of the lighting effect.



No Color

Removes color formatting from this element.



Automatic Color

Changes the selected object element to the preset color from the color scheme. To see which color will be used 
for an object element, point to each color on this menu until its ScreenTip appears.



Color Scheme

Click the color you want for the selected object. To use a color that is not in the color scheme, click More Colors.



Standard Colors

Click the color you want, or click More Colors and then pick a different color.



Recently Used Colors

These are the nonstandard colors you most recently used. Click a color here to quickly use it again.





Arrow Size

Click the arrowhead size you want for the arrows on the selected line.



Direction

Click the direction in which you want the 3-D effect to extend. Click the button in the middle if you want the 3-D 
effect to extend straight back behind the shape.



Simple Gradient Color

Click the gradient fill color you want for the selected object.



Pattern Foreground Color

Click the foreground color you want for the pattern.



Pattern Background Color

Click the background color you want for the pattern.



Connector Style

Click the type of connector you want.



Patterned Lines

Opens the list of patterns that you can use for the selected line.



Edit Picture

Activates the picture editor so you can edit the selected picture.



Open Picture

Opens the selected picture in the picture editor, where you can edit it.



Custom Depth

Click Custom, and then type the extrusion depth you want. The default unit is points, but you can type the value 
in centimeters, inches, or points ¾ for example, type 2 cm. or .75 in.



Custom Width

Enter the width you want for the selected line.



Line Width

Click the width you want for the selected line.





WordArt Gallery

Opens the WordArt Gallery dialog box, in which you can choose a different WordArt style for the selected 
WordArt object.



Border

Click the type of border or line style you want to add to the selection.



Custom

Enter a percentage from 1 through 499 to decrease or increase the character spacing in the selected WordArt 
object.



Line Tool

Displays the line tools you used recently so you can use them again easily.



Shape Tool

Displays the AutoShape tools you used recently so you can use them again easily.



Color Picker

Click the color you want for the selected items.



Drag to make this menu float

Drag the horizontal bar to change this drop-down menu into a floating toolbar.



Two-headed Arrow

Draws a two-headed arrow where you click or drag in the active window. To constrain the line to draw at 15-
degree angles from its starting point, hold down SHIFT as you drag.



Fill Color

Adds, modifies, or removes the fill color or fill effect from the selected object. Fill effects include gradient, texture, 
pattern, and picture fills.



Line Color

Adds, modifies, or removes the line color from the selected object.



Shadow Color

Changes the shadow color of the selected object.



3-D Color

Click the color you want for the 3-D effect on the selected object.





Fax Recipient

Sends the active document as a fax. The Fax Wizard will assist you to set up your fax. 



Versions (File menu)

Saves and manages multiple versions of a document in a single file. After you save versions of a document, you 
can go back and review, open, print, and delete earlier versions.



Font

Changes the font of the selected text and numbers. In the Font box, select a font name.



Zoom

Enter a magnification between 15 and 400 percent to reduce or enlarge the display of the active document.



Line Style

Click the style and thickness you want for the selected line.



Publish It

Opens the active file in Microsoft Publisher.





Semitransparent

Makes the shadow on the selected object partially transparent.





Font Color

Click the color you want for the selected text.



Color

Click the color you want.



Pattern

Click the pattern you want for the selected object.



Border Color

Click the color you want for the selected line or border.



Textbox

Draws a text box where you click or drag in the active window. Use a text box to add text — such as captions or 
callouts — to your pictures or graphics.



Paste Link

Links the pasted data to its source document.



Convert

Converts an OLE object from one object type to another.



Fill Color and Pattern

Sets the pattern and the foreground color for the fill of the selected object.





Curved Connector

Changes the selected connector line to a curved connector.



Elbow Connector

Changes the selected connector line to an elbow connector.



Straight Connector

Changes the selected connector line to a straight connector.



Edit Text

Opens the Edit WordArt Text dialog box, where you can edit the text of the selected WordArt object.





Shadow On/Off

Turns on shadow formatting for the selected object using the default shadow settings, or turns off shadow 
formatting. Shadow and 3-D formatting are mutually exclusive ¾ if you turn on shadow formatting, any 3-D 
settings are automatically turned off, and vice versa.



Set AutoShape Defaults

Changes the default AutoShape settings to match those of the currently selected AutoShape. When you insert a 
new AutoShape, it is automatically formatted with the new default settings.



Clear

Clears any custom AutoShape default settings and restores the built-in default settings.



Align or Distribute Relative to Slide (Draw menu)

Aligns or distributes the selected objects relative to the slide. If you want to align or distribute the objects relative 
to one another, clear the check mark next to the command.



Align or Distribute Relative to Drawing (Draw menu)

Aligns or distributes the selected objects relative to the drawing. If you want to align or distribute the objects 
relative to one another, clear the check mark next to the command.



No Shadow

Removes shadow formatting from the selected object.



No 3-D

Removes 3-D formatting from the selected object.



Send To Mail Recipient (File menu)

Sends the current file as an attachment to a mail message.





Draw Unselect

Cancels the selection of the selected drawing object and moves the insertion point to the beginning of the 
paragraph that contains the corresponding anchor. If more than one drawing object is selected, Draw Unselect 
moves the insertion point to the first paragraph that contains an anchor for at least one of the selected objects.



Draw Select Next

Selects the next drawing object, where "next" means next closest to the top in a stack of drawing objects. If the 
topmost object is selected, Word selects the bottom-most object.



Draw Select Previous

Selects the previous drawing object, where "previous" means next closest to the bottom in a stack of drawing 
objects. If the bottommost object is selected, Word selects the topmost object.



Create Text Box Link

Links two text boxes so that text flows in a story from one text box to the next. The text box you link to must be 
empty and not linked to another story. Linked text boxes must be in the same document.



Break Forward Link

Breaks the forward link to the selected text box. When you break a link in a story, you create two stories; the links
before and after the break stay intact, but the text stops flowing at the last text box before the broken link.



Next Text Box

Selects the next text box in the story, which is the forward link to the currently selected text box.



Previous Text Box

Selects the previous text box in the story, which is the backward link to the currently selected text box.



Shading

Changes the background shading of paragraphs and table cells.



Borders

Changes the borders of paragraphs, table cells, and pictures.



Minimize

Reduces an application or document window to an icon. To restore the window to its previous size and location, 
click or double-click the title bar.



Maximize

Enlarges an application or document window to fill the screen. To restore the window to its previous size and 
location, click or double-click the title bar.



Restore

Restores a window to its previous size and location.





Char Left

Moves the insertion point one character to the left. This is the equivalent of pressing the LEFT ARROW key.



Char Right

Moves the insertion point one character to the right. This is the equivalent of pressing the RIGHT ARROW key.



Word Left

Moves the insertion point one word to the left. This is the equivalent of pressing CTRL+LEFT ARROW.



Word Right

Moves the insertion point one word to the right. This is the equivalent of pressing CTRL+RIGHT ARROW.



Sent Left

Moves the insertion point one sentence to the left. Word counts empty table cells as "sentences" and, regardless 
of length or punctuation, considers every paragraph to contain at least one sentence.



Sent Right

Moves the insertion point one sentence to the right. Word counts empty table cells as "sentences" and, 
regardless of length or punctuation, considers every paragraph to contain at least one sentence.



Para Up

Moves the insertion point up by one paragraph. If the insertion point is at the beginning of a paragraph, the 
insertion point moves to the beginning of the previous paragraph. If the insertion point is not at the beginning of 
the paragraph or if there is a selection, the insertion point moves to the beginning of the current paragraph. If the 
current selection extends over multiple paragraphs, the insertion point moves to the beginning of the first 
selected paragraph.



Para Down

Moves the insertion point down by one paragraph to the start of the next paragraph. If the insertion point is in the 
last paragraph of the document, the insertion point moves only to the end of the paragraph. If the current 
selection extends over multiple paragraphs, the insertion point moves to the beginning of the first paragraph 
following the end of the selection.



Line Up

Moves the insertion point up by one line.



Line Down

Moves the insertion point down by one line.



Char Left Extend

Selects one character to the left of the insertion point. This is the equivalent of pressing SHIFT+LEFT ARROW.



Char Right Extend

Selects one character to the right of the insertion point. This is the equivalent of pressing SHIFT+RIGHT ARROW.



Word Left Extend

Selects one word to the left. This is the equivalent of pressing CTRL+SHIFT+LEFT ARROW.



Word Right Extend

Selects one word to the right. This is the equivalent of pressing CTRL+SHIFT+RIGHT ARROW.



Sent Left Extend

Selects one sentence to the left. Word counts empty table cells as "sentences" and, regardless of length or 
punctuation, considers every paragraph to contain at least one sentence. If there is already a selection, this 
command moves the active end of the selection toward the beginning of the document.



Sent Right Extend

Selects one sentence to the right. Word counts empty table cells as "sentences" and, regardless of length or 
punctuation, considers every paragraph to contain at least one sentence. If there is already a selection, this 
command moves the active end of the selection toward the end of the document



Para Up Extend

Extends the selection to the beginning of the previous paragraph. If there is already a selection, this command 
moves the active end of the selection toward the beginning of the document.



Para Down Extend

Extends the selection to the beginning of the next paragraph, or selects the next paragraph if the insertion point 
is at the end of a paragraph. If the insertion point is in the last paragraph of the document, the selection extends 
only to the end of the paragraph. If the current selection extends over multiple paragraphs, the selection extends 
to the beginning of the first paragraph following the end of the selection.



Line Up Extend

Extends the selection up one line.



Line Down Extend

Extends the selection down one line.



Page Up Extend

Extends the selection and changes the document display to the previous screen of text.



Page Down Extend

Extends the selection and changes the document display to the next screen of text.



Start of Line Extend

Extends the selection to the beginning of the current line.



End of Line Extend

Extends the selection to the end of the current line.



Start of Window Extend

Extends the selection to the beginning of the first visible line on the screen.



End of Window Extend

Extends the selection to the end of the last visible line on the screen.



Start of Doc Extend

Extends the selection to the beginning of the first line of the document.



End of Doc Extend

Extends the selection to the end of the last line of the document.





New

Creates a new, blank document based on the default template.



Next Routing Recipient

Forwards the active document to the next reviewer on the routing slip.



Other Routing Recipient

Forwards the active document to the reviewer you select on the routing slip.



Toggle Fill On/Off

Removes the fill from the selected object, or adds the default fill to the selected object.



Toggle Line On/Off

Removes the line from the selected object, or adds the default line to the selected object.





Align Top

Aligns the selected vertical text, numbers, or inline objects with the top edge of the text box or table cell, with a 
ragged bottom edge.



Align Bottom

Aligns the selected vertical text, numbers, or inline objects with the bottom edge of the text box or table cell, with 
a ragged top edge.



Center

Centers the selected vertical text, numbers, or inline objects between the top and bottom edges of the text box or
table cell.



Justify

Aligns the selected vertical text, numbers, or inline objects with both the top and bottom edges of the text box or 
table cell.



Send (File menu)

Sends the item to the names specified on the To, Cc, or Bcc box.



Properties

Sets properties for electronic mail messages.



Picture From File (Insert menu)

Inserts an existing picture in the active Microsoft Draw object.



AutoShapes Menu

Displays the AutoShape categories you can insert. Click an AutoShape category, click the AutoShape you want, 
and then click or drag in the active window where you want to insert the AutoShape. To draw an AutoShape that 
retains its default height-to-width ratio, hold down SHIFT while you drag.



Lines Menu

Click the AutoShape you want to insert, and then click or drag in the active window where you want to insert the 
AutoShape. To draw an AutoShape that retains its default height-to-width ratio, hold down SHIFT while you drag.



Basic Shapes Menu

Click the AutoShape you want to insert, and then click or drag in the active window where you want to insert the 
AutoShape. To draw an AutoShape that retains its default height-to-width ratio, hold down SHIFT while you drag.



Connectors Menu

Click the AutoShape you want to insert, and then click or drag in the active window where you want to insert the 
AutoShape. To draw an AutoShape that retains its default height-to-width ratio, hold down SHIFT while you drag.



Sun

Draws a sun where you click or drag in the active window. To draw a sun that retains its default height-to-width 
ratio, hold down SHIFT while you drag.



Moon

Draws a moon where you click or drag in the active window. To draw a moon that retains its default height-to-
width ratio, hold down SHIFT while you drag.



Double Bracket

Draws a double bracket where you click or drag in the active window. To draw a double bracket that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



Double Brace

Draws a double brace where you click or drag in the active window. To draw a double brace that retains its 
default height-to-width ratio, hold down SHIFT while you drag.



4-Point Star

Draws a 4-point star where you click or drag in the active window. To draw a star that retains its default height-to-
width ratio, hold down SHIFT while you drag.



Double Wave

Draws a double wave where you click or drag in the active window. To draw a double wave that retains its default
height-to-width ratio, hold down SHIFT while you drag.



Straight Arrow Connector

Draws a straight arrow connector line between the blue connection sites that you click on two AutoShapes. Click 
the connection site on the first object, drag the connector to the second object, and then click a connection site.



Straight Double-Arrow Connector

Draws a straight double-arrow connector line between the blue connection sites that you click on two 
AutoShapes. Click the connection site on the first object, drag the connector to the second object, and then click 
a connection site.



Elbow Arrow Connector

Draws a 90-degree angled arrow connector line between the blue connection sites that you click on two 
AutoShapes. Click the connection site on the first object, drag the connector to the second object, and then click 
a connection site.



Elbow Double-Arrow Connector

Draws a 90-degree angled double-arrow connector line between the blue connection sites that you click on two 
AutoShapes. Click the connection site on the first object, drag the connector to the second object, and then click 
a connection site.



Curved Arrow Connector

Draws a curved arrow connector line between the blue connection sites that you click on two AutoShapes. Click 
a connection site on the first object, drag the connector to the second object, and then click a connection site.



Curved Double-Arrow Connector

Draws a curved double-arrow connector line between the blue connection sites that you click on two 
AutoShapes. Click a connection site on the first object, drag the connector to the second object, and then click a 
connection site.



Change AutoShape to Sun

Changes the selected AutoShape to a sun symbol.



Change AutoShape to Moon

Changes the selected AutoShape to a moon symbol.



Change AutoShape to Double Bracket

Changes the selected AutoShape to a double bracket symbol.



Change AutoShape to Double Brace

Changes the selected AutoShape to a double brace symbol.



Change AutoShape to 4-Point Star

Changes the selected AutoShape to a 4-point star symbol.



Change AutoShape to Double Wave

Changes the selected AutoShape to a double wave symbol.



Split Point

Splits the selected edit point into two points.



Delete Segment

Deletes the selected segment.



Open Curve

Adds a small break between the beginning and end of a closed curve line.



Fill Effects

Opens the Fill Effects dialog box, where you can pick a picture, gradient, textured, or patterned fill.



Format Drawing Object

Formats the line, color, fill and pattern, size, position, and other properties of the selected object.



Save as HTML (File menu)

Saves the active file in HTML file format — ready to publish to the World Wide Web.





Set Transparent Color

Sets the transparent color for the selected bitmap. Click the color you want to make transparent. This tool works 
only on bitmap images.



Exit Text Edit

Turns off text-editing for the selected text box or AutoShape.



Fit to Page (Window menu)

Places each open presentation in its own window, complete with title bar, scroll bars, and view buttons. The 
active presentation remains in front.





Custom Button

A custom button you can assign a macro to.





List Windows

Click the window you want to switch to.



Bullets

Adds bullets to the selected paragraphs.



Numbering

Adds numbers to the selected paragraphs.



Fill/Back Color

Click the fill or background color you want.



Font/Fore Color

Click the font or foreground color you want.





Update

Updates the embedded object in the host file.



Group

Defines the selected rows or columns of detail data as a group in an outline, so you can summarize the data. If 
you have not created an outline, this command creates one for you.

In a PivotTable, this command groups items by category to create a single item from multiple items; for example, 
you can group days, weeks, months, or other dates into quarters for analysis, charting, or printing.



Ungroup

Removes selected rows or columns from a group on an outlined worksheet.

In a PivotTable, this command separates each instance of a group into the items contained in the group; for 
example, it separates quarters into the original individual dates.



Cascade (Window menu)

Rearranges all open windows, so that they overlap in a cascade. The title bar and a portion of each window are 
visible.





This command may not be available if your workbook is in protected mode. For more information, click the Help 
command on the Help menu in your program, and then search on the feature you want to know more about.



This command may not be available if you have not cut or copied an object, text, or contents of a cell to the 
Clipboard. For more information, click the Help command on the Help menu in your program, and then search on
the feature you want to know more about.



This command may not be available if you have a chart selected. Click outside the chart area, and then try this 
command again.





Displays the type of object that you are converting or activating.



Converts the object from the Current type to the application format or information type selected in the Object 
type box.



Opens the object as the type selected in the Object type box, but returns the object to Current type after 
editing.



Click the application or object type you want to use to convert or open the selected object. If the object type you 
want does not appear in this box, you may need to run Office Setup to install the source application.



Displays the selected object as an icon. To open or edit the object, double-click the icon.



Displays the icon Word will use for the selected object. To use a different icon, click Change Icon.



Changes the icon that represents the selected object.



Describes the effect of selected options.





Click the object type you want to insert in your document. If the object type you want does not appear, you may 
need to run Office Setup to install the source application.



Type the name of the file you want to insert as a linked or embedded object, or click Browse to locate it. 



Locates the file you want to link or embed.



Displays the linked or embedded object as an icon.



Displays the icon Word will use for the selected object. To use a different icon, click Change Icon.



Changes the icon that represents the selected object.



Displays the linked or embedded object as an icon.



Describes the results of selected options.





Click the type of information you want to paste from the Clipboard.



Displays the linked or embedded object as an icon. To open or edit the object, double-click the icon.



Displays the icon Word will use for the selected object. To use a different icon, click Change Icon.



Changes the icon that represents the selected object.



Displays the file format, source application, and selection area for the Clipboard contents.



Click the type of information you want to paste from the Clipboard.



Displays the linked or embedded object as an icon. To open or edit the object, double-click the icon.



Inserts or embeds the Clipboard contents at the insertion point in the format you select in the As box. This option
pastes or embeds the Clipboard contents, but no link is created.



Inserts the Clipboard contents and creates a link to the source file for the data. This option is available only when
the Clipboard contents come from an application that supports linking. Be sure to save the source file in the 
source application before you link it in Microsoft Draw.



Describes the effect of selected options.





Sets the position of selected paragraphs relative to the indents. To align text relative to the left and right margins, 
click (none) in the Type box.



Click First line to indent only the first line of a paragraph. Click Hanging to indent all but the first line of a 
paragraph. Click (none) to remove special indentation formatting.



Enter the amount of indentation for a first-line or hanging indent. Microsoft Draw clears this box if you click 
(none) in the Type list.



Sets the amount of space above each selected paragraph.



Sets the amount of space below each selected paragraph.



Enter the amount of vertical space you want between lines of text.



Uses the currently selected options as the default settings for all new paragraphs you insert in your Microsoft 
Draw objects.





Align and arrange objects
You can align objects with other objects, such as when you align the sides, middles, or top or bottom edges of 
objects. You can also align objects by using the grid to align them with a corner on the grid as you draw or move 
the objects.

You can also arrange (or distribute) objects so they are equal distances from each other ¾ either vertically or 
horizontally.

What do you want to do?

            Align objects with other objects  
            Align objects on a grid  
            Arrange objects equal distances from each other  



Arrange objects equal distances from each other
1 Select the objects you want to arrange.

You must select three or more objects.
2 Click Draw on the Drawing toolbar, and then click Align or Distribute.
3 To arrange objects equal distances from each other, click Distribute Horizontally or Distribute Vertically.



Move an object or group of objects
1 Select the object, multiple selection, or group you want to move.
2 Drag the object to its new location.
Tip      To constrain an object so it moves only horizontally or vertically, press SHIFT as you drag the object.



"Nudge" an object in small increments
1 Select the object you want to nudge.
2 On the Drawing toolbar, click Draw, point to Nudge, and then click the direction you want to nudge the object.

Each click moves the object 1 grid unit if Snap to Grid is on, and 1 pixel if Snap to Grid is off.
Tip      You can also nudge an object in 1-pixel increments by selecting the object, holding down CTRL and 
pressing the arrow keys.



Align objects with other objects
1 Select the objects you want to align.
2 Click Draw on the Drawing toolbar, click Align or Distribute, and then click the option you want.



Align objects on a grid
· To automatically align objects on an invisible grid, click Draw on the Drawing toolbar, click Snap, and then 

click To Grid    .
· To automatically align objects with gridlines that go through the vertical and horizontal edges of other 

shapes, click Draw on the Drawing toolbar, click Snap, and then click To Shape    .



Turn off the grid temporarily
· To temporarily override the grid, press ALT as you drag or draw an object.



Troubleshoot aligning and arranging objects

What do you need help with?

            I aligned my objects, and they're stacked on top of each other.  
            Items on the   Align or Distribute   menu appear dimmed, and I can't select them.  



I aligned my objects, and they're stacked on top of each other.
Depending on the alignment option you click, objects will move straight up, down, left, or right and might cover an

object already there. You can undo the alignment if you click Undo     and then move objects to new positions
before you align them again.



Items on the Align or Distribute menu appear dimmed, and I can't select them.
You must select at least two objects to make the alignment options available and at least three objects to make 
the distribution options available.



Position an object in relation to the page
In most cases you simply drag your objects to where you want them. However, to place an object in a precise 
position, use this procedure.

1 Select the object you want to position.
2 On the Format menu, click Position.
3 In the Horizontal and Vertical boxes, enter the distances from the upper left-hand corner of the page.



Position objects
The simplest way to position an object is by dragging it to the location you want. For more precision, you can 
nudge an object in 1-pixel increments. Turning off the grid might help you place an object exactly where you want
it. You can also place an object in relation to the whole page.

What do you want to do?

            Move an object or group of objects  
            "Nudge" an object in small increments  
            Position an object in relation to the page  
            Turn off the grid temporarily  
            Display or hide the rulers  



Display or hide the rulers
You can use the horizontal and vertical rulers to move and align objects precisely.

· Click Ruler    .
Note      The rulers are only available if you are working in a Microsoft Draw window; they are not available when 
working on a page in a host program.





Resize or crop an object
When you select an object, sizing handles appear at the corners and along the edges of its selection rectangle. 
You can resize an object by dragging its sizing handles, or you can resize it more precisely by specifying a 
percentage for the object's height and width.

If the object is a picture ¾ a photo, bitmap, or clip art, for example ¾ you can crop it, and you can also restore it 
later to its original size.

What do you want to do?

            Resize an object  
            Resize an object by a specific percentage  
            Maintain the proportions of an object while resizing it  
            Crop or trim portions of a picture  



Resize an object
1 Select the object you want to resize.
2 Drag a sizing handle until the object is the shape and size you want.

For information about maintaining the proportions of an object while resizing it, click    .



Maintain the proportions of an object while resizing it
To resize a selected object Hold down
Proportionally from a corner SHIFT and drag a 

corner sizing handle
Vertically, horizontally, or diagonally 
from the center outward

CTRL and drag a 
sizing handle

Proportionally from the center 
outward

CTRL+SHIFT and 
drag a corner sizing 
handle

While temporarily overriding the 
settings for the grid

ALT and drag a sizing
handle



Resize an object by a specific percentage
1 Select the object you want to resize.
2 On the Format menu, click Size.
3 Under Scale, enter the percentages you want in the Height and Width boxes.
Tip      To maintain the ratio between height and width, select the Lock aspect ratio check box.



Crop or trim portions of a picture
1 Select the picture you want to crop.
2 On the Picture toolbar, click Crop    .

3 Position the cropping tool over a sizing handle, and drag.

Tip      To restore the picture to its original size, click Format Picture        on the Picture toolbar, click the Size 
tab, and then click Reset.





Troubleshoot selecting

What do you need help with?

            I want to select an object, but I can't see it.  
            I want to select an object that's close to other objects.  



Select an object hidden behind another object
· Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until sizing handles 

appear on the object you want to select.
Tip      If an object you want to work on is in a stack, you can bring it to the top of the stack. Select the object, 
point to Order on the Draw menu, and then click Bring to Front.



Select an object or cancel a selection
To Do this
Select a filled object Click anywhere within the 

object. Sizing handles 
indicate the object is 
selected.

Select an unfilled object Click the object's border.
Cancel a selected 
object

Click outside the object.

Tip      To select multiple objects, hold down SHIFT while you click each object. To cancel one of the selected 
objects, click the object again while holding down SHIFT.



I want to select an object, but I can't see it.
The object might be hidden behind another object, or it might not have a color or border. Press the TAB key to 
cycle through the objects until sizing handles appear on the object you want to select.



I want to select an object that's close to other objects.
· Select one of the other objects, and then press the TAB key until the object you want is selected.

· Try working in a larger view. Click the arrow next to the Zoom box        to magnify the view and 
make it easier to select objects that are close together.





Add, change, or remove a shadow
You can add a shadow to any object you create ¾ including text boxes ¾ and you can change the size, direction,
and color of shadows. When you change the color of a shadow, the change affects only the shadow, not the 
object itself. You can also add an embossed or engraved effect to an object, and you can add some types of 
shadows ¾ an offset shadow, for example ¾ to the borders of pictures.

What do you want to do?

            Add a shadow to an object  
            Add an embossed or engraved effect to an object  
            Change the color of a shadow  
            Change the offset direction of a shadow  
            Remove a shadow  



Remove a shadow
1 Select the object you want to change.

2 On the Drawing toolbar, click Shadow    , and then click No Shadow.



Change the color of a shadow
1 Select the object you want to change.

2 On the Drawing toolbar, click Shadow    , and then click Shadow Settings.

3 On the Shadow Settings toolbar, click the arrow next to Shadow Color    .
4 Click the color you want.

If you don't see the color you want, click More Shadow Colors. Click a color on the Standard tab, or click the
Custom tab to mix your own color, and then click OK.



Change the offset direction of a shadow
1 Select the object you want to change.

2 On the Drawing toolbar, click Shadow    , and then click Shadow Settings.
3 On the Shadow Settings toolbar, click any of the four Nudge Shadow buttons to create the effect you want.

Clicking a Nudge Shadow button nudges the shadow 1 pixel. To nudge the shadow 6 pixels, hold down SHIFT
while you click a Nudge Shadow button.



Add an embossed or engraved effect to an object
1 Select the object you want to add the effect to.

2 On the Drawing toolbar, click Shadow    .

3 To add an embossed effect, click Shadow Style 17    .

To add an engraved effect, click Shadow Style 18    .
Note      To better display either of these effects, the border of an object disappears when the effect is added. To 
add the border back, select the object, click the arrow next to Line Color    , and then click a color for the 
border.



Add, change, or remove a 3-D effect
You can add a 3-D effect to most AutoShapes, lines, and freeform objects. With 3-D options, you can change the 
depth (the extrusion) of the object and its color, rotation, angle, direction of lighting, and surface texture. When 
you change the color of a 3-D effect, the change affects only the 3-D effect, not the object itself. An object can 
have either a shadow or a 3-D effect, but not both ¾ if you apply a 3-D effect to an object that has a shadow, the 
shadow disappears.

What do you want to do?

            Add or change a 3-D effect  
            Change the color of a 3-D effect  
            Remove a 3-D effect  



Change the color of a 3-D effect
1 Select the object you want to change.

2 On the Drawing toolbar, click 3-D    , and then click 3-D Settings.

3 On the 3-D Settings toolbar, click the arrow next to 3-D Color    .
4 Click the color you want.

If you don't see the color you want, click More 3-D Colors. Click a color on the Standard tab, or click the 
Custom tab to mix your own color, and then click OK.
To change the 3-D color back to its default, click Automatic.



Add or change a 3-D effect
1 Select the object you want to change.

2 On the Drawing toolbar, click 3-D    .
To add a 3-D effect, click the option you want.

To change a 3-D effect ¾ for example, its color, rotation, depth, lighting, or surface texture ¾ click 3-D        
again, click 3-D Settings, and then click the options you want on the 3-D Settings toolbar.

Tip      To add the same 3-D effect to several objects at one time ¾ the same color, for example ¾ select or group 
the objects before you add the effect.



Remove a 3-D effect
1 Click the object you want to change.

2 On the Drawing toolbar, click 3-D    , and then click No 3-D.



Troubleshoot adding borders, fills, shadows, and 3-D effects

What do you need help with?

            I can't see the border around an object.  
            I changed the fill, border, shadow, or 3-D effect, but when I draw an object, I get the old settings.  
            I added a 3-D effect to my object and the object shadow disappeared, or I added a shadow and the 3-D   

effect disappeared.
            When I change the fill color of an object with a shadow or 3-D effect, the shadow or 3-D effect doesn't   

change color.



When I change the fill color of an object with a shadow or 3-D effect, the shadow or 3-
D effect doesn't change color.
Changing the fill color only affects the face of the object. To change the color of the shadow or 3-D effect, use the
Shadow or 3-D tools on the Drawing toolbar.



I added a 3-D effect to my object and the object shadow disappeared, or I added a 
shadow and the 3-D effect disappeared.
You can't apply both a shadow and a 3-D effect to the same object.



I can't see the border around an object.
· Adding a 3-D effect to an object turns off its border.
· The border has been turned off, the border is the same color as the background, or an embossed or engraved

effect has been added to the object. To add a visible border, select the object. On the Drawing toolbar, click 
the arrow next to Line Color    , and then click a color for the border. If an object has a 3-D effect, however, 
it can’t have a visible border too.



I changed the fill, border, shadow, or 3-D effect, but when I draw an object, I get the 
old settings.
The default style is being applied to the new object.

· To change the default settings for new objects, select an object that has the attributes you want. On the 
Drawing toolbar, click Draw, and then click Set AutoShape Defaults.

Tip      To change the default attributes of text, select the text, click Font on the Format menu, and then select the
Default for new objects check box.



Add a shadow to an object
1 Select the object you want to add a shadow to.
2 On the Drawing toolbar, click Shadow    , and then click the option you want.
Tip      To change the color or offset of a shadow, click Shadow    , click Shadow Settings, and then click the 
options you want on the Shadow Settings toolbar.





What is Microsoft Draw?
Microsoft Draw is the fastest and easiest way to create colorful, professional-quality illustrations and graphics. It's
ideal for drawing as well as making captions, callouts, flowcharts, and diagrams.

Microsoft Draw comes with a large number of ready-made shapes ¾ called AutoShapes ¾ plus tools for creating 
your own shapes and drawings. The Drawing toolbar ¾ located at the bottom of the screen by default ¾ 
provides tools you can use to draw, manipulate, and format all kinds of drawing objects. These shapes and 
drawings can be:

· Resized, rotated, and flipped.
· Filled with solid or gradient colors, patterns, textures, or pictures.
· Enhanced with a variety of shadow or 3-D effects.
· Combined with other shapes to make more complex drawings.
· Arranged in a variety of ways in relation to each other or to the page.
You can add text directly to an AutoShape, apply styles and formatting to the text, and even control the position 
of text within the shape. You can use the Text Box tool on the Drawing toolbar to add text anywhere in a 
drawing, and you can use the Insert WordArt tool on the Drawing toolbar to create shadowed, skewed, rotated, 
and stretched text, as well as text that fits predefined shapes.



Edit a drawing
· To edit a drawing while it remains on the page, double-click the drawing.
· To edit a drawing in a Microsoft Draw window, right-click the drawing and then click Open Drawing Object.



Exit Microsoft Draw
· If you're working on a page in the host program, click anywhere on the page outside the drawing.
· If you're working in a Microsoft Draw window, click Exit & Return to on the File menu.



Save changes to a drawing
· If you're working on a page in the host program, click anywhere on the page outside the drawing.
· If you're working in a Microsoft Draw window, click Update on the File menu.



Create a drawing
1 On the Insert menu in the host program, click Object, click Create New, click Microsoft Draw 98 Drawing, 

and then click OK.
2 Use the drawing tools to create your drawing.
3 When your drawing is finished, click anywhere on the page outside the drawing.





Exit and return to Program

Exits Microsoft Draw and returns to the host application.



Duplicate

Makes a quick copy of a selected object. To make additional copies of the same object, click Repeat Duplicate 
(Edit menu).



Toggle Selection

Toggles between AutoShape selection and text-selection mode.



Edit/Open Object

Activates the application in which the selected object was created, so you can edit or play the object. Click Edit 
to activate the object in place. Click Open to activate the object in a separate window.



Edit/Open Object

Activates the application in which the selected object was created, so you can edit or play the object. Click Edit 
to activate the object in place. Click Open to activate the object in a separate window.



Edit/Open Object

Activates the application in which the selected object was created, so you can edit or play the object. Click Edit 
to activate the object in place. Click Open to activate the object in a separate window.



Convert

Converts the selected OLE object from one object type to another.



Standard (View menu, Toolbars command)

Displays or hides the Standard toolbar. To display a toolbar, select the check box next to the toolbar name. To 
hide a toolbar, clear the check box.



Formatting (View menu, Toolbars command)

Displays or hides the Formatting toolbar. To display a toolbar, select the check box next to the toolbar name. To 
hide a toolbar, clear the check box.



Lines (Insert menu)

Displays or hides the Lines toolbar.



Connectors (Insert menu)

Displays or hides the Connectors toolbar.



Basic Shapes (Insert menu)

Displays or hides the Basic Shapes toolbar.



Callouts (Insert menu)

Displays or hides the Callouts toolbar.



Block Arrows (Insert menu)

Displays or hides the Block Arrows toolbar.



Stars and Banners (Insert menu)

Displays or hides the Stars and Banners toolbar.



Flowchart (Insert menu)

Displays or hides the Flowchart toolbar.



Align Top

Aligns the selected text box with the top edge of the inscribed rectangle of the AutoShape.



Align Middle

Vertically centers the selected text box in the inscribed rectangle of the AutoShape.



Align Bottom

Aligns the selected text box with the bottom edge of the inscribed rectangle of the AutoShape.



Context Sensitive Help

Click        and then click a menu command or toolbar button to display online Help about the item.



Shortcut Menu

Opens the shortcut menu.



Unselect All

Cancels the current selection.



Edit Text (WordArt toolbar)

Opens the Edit WordArt Text dialog box, where you can edit the text of the selected WordArt object.



Colors and Lines (Format menu)

Formats the colors and lines of the selected drawing objects.



Size (Format menu)

Formats the size of the selected drawing objects



Position (Format menu)

Formats the horizontal and vertical position of the selected drawing objects.



Picture (Format menu)

Crops the selected picture and changes its color, brightness, and contrast.



Text Box (Format menu)

Formats the alignment and margins of the selected text box.



Displays the version number of this Microsoft program and all applicable copyright, legal, and licensing notices.





Ways to add text
You can add text to an AutoShape ¾ except to lines, connectors, and freeforms ¾ in such a way that the text 
attaches to the shape and moves with it if you move the shape.

You can also use the Text Box tool to add text outside a shape ¾ for example, to add captions or callouts to your
graphics. Text added with the Text Box tool isn't attached to a shape ¾ it won't move if you move a shape.

What do you want to do?

            Add text to an AutoShape  
            Add text by using the Text Box tool  
            Convert a text box to an AutoShape  



Add text to an AutoShape
· Click any shape ¾ except a line, connector, or freeform ¾ and then start typing.
Note      The text is attached to the object and is treated as part of the object. If you don't want to attach the text, 
use the Text Box tool on the Drawing toolbar to insert the text where you want it.



Select text
To work with text in an AutoShape or text box, right-click the object, and then click Edit Text.

To select Do this
A word Double-click the word.
All text in an object Press CTRL+A.

Change the way text looks
1 Select the text you want to change.
2 On the Format menu, click Font.
3 Select the options you want.
Tip      You can also make some formatting changes ¾ such as font, font style and size, and alignment ¾ by using
the tools on the Formatting toolbar.



Change the default style for new text
1 On the Format menu, click Font.
2 Select the options you want for the new default text style.
3 Select the Default for new objects check box.
Tip      To change the default style for paragraph formatting, select the paragraph that has the formatting you 
want, click Paragraph on the Format menu, and then select the Default for new objects check box.



Add or remove bullets
1 Select the text you want to add bullets to or remove them from.

2 Click Bullets    .



Troubleshoot text in objects

What do you need help with?

            I can't move a text object or a shape with text.  
            I want to change the format for a line of text, but the whole paragraph changes.  
            Text won't move or rotate with its object.  
            When I select a text object and start typing, the existing text isn't replaced with what I type.  



Text won't move or rotate with its object.

Text created with the Text Box tool        and placed on top of an object isn't attached to the object. It won't 
move or rotate with the object.

· To create text that becomes part of the object, right-click the object, and then click Add Text on the shortcut 
menu.

· To group the text box and object so they move as a single unit, hold down SHIFT as you select the text box 
and object, and then click Group    .

· To convert text in a text box to text attached to a shape, select the text box, click Draw on the Drawing 
toolbar, click Change AutoShape, and then select the AutoShape you want.



I can't move a text object or a shape with text.
Select the object by clicking its border, and then drag.



When I select a text object and start typing, the existing text isn't replaced with what I 
type.
Make sure you select the text itself ¾ not the border of the object ¾ before you start typing.



I want to change the format for a line of text, but the whole paragraph changes.
· Select only the text you want to change. If you select an entire paragraph, the changes you make affect all 

text in the paragraph.
· Some formatting changes ¾ such as line spacing, alignment, bullets, and tabs ¾ affect the entire paragraph 

and can't be applied to a single line.



Position, align, and space text in an AutoShape or text box
When text is attached to an AutoShape, you can change the position of the text or change the amount of space 
between the text and the edge of the object. To attach text to an object, select the object, and then start typing.

Note      Text in a text box can be positioned, aligned, and spaced the same way as text in an AutoShape.

What do you want to do?

            Position text in an object  
            Change the margins around text in an object  



Position text in an object
1 Select the object that has the text you want to position.
2 On the Format menu, click Text Box.
3 In the Vertical alignment list, click the position where you want the text to start.
4 Under Internal margin, increase or decrease the distance between the text and the sides of the object.



Change the margins around text in an object
1 Select the object that has the text whose margins you want to change.
2 On the Format menu, click Text Box.
3 Under Internal margins, increase or decrease the distance between the text and the object.



Change text color
1 Select the text you want to change.

2 On the Drawing toolbar, click the arrow next to Font Color    .
3 Click the color you want.

If you don't see the color you want, click More Font Colors. Click a color on the Standard tab, or click the 
Custom tab to mix your own color, and then click OK.



Make text larger or smaller
1 Select the text you want to change.

2 Click Increase Font Size        or Decrease Font Size    

.



Add text by using the Text Box tool

1 On the Drawing toolbar, click Text Box    .
2 To make a 1-inch-by-1-inch text box, click where you want to add the text, and then start typing.

To make a text box of any size, drag to the size you want, and then start typing.
Tip      To change a text box to any AutoShape, select the text box, click Draw on the Drawing toolbar, point to 
Change AutoShape, point to a category, and then click the shape you want.



Cancel or undo an action
1 Click the arrow next to Undo        to see the most recent actions you can undo. You can scroll to see more 

actions.
2 Click the action you want to undo.

When you undo an action, you also undo all actions listed above it.
Tip      If you change your mind after you click Undo, you can click Redo        to restore the action.



Edit and format text
Text in an AutoShape or text box can be changed and formatted in much the same way as any other text. You 
can change the way text looks by selecting different fonts, font styles and sizes, and colors. You can change the 
alignment of text, format paragraphs, and add bullets. You can also save text attributes as the default style for 
new text.

What do you want to do?

            Add or remove bullets   
            Change text color  
            Change the default style for new text  
            Change the way text looks  
            Make text larger or smaller  
            Select text  



Convert a text box to an AutoShape
You can convert text in a text box to an AutoShape with attached text.

1 Select the text box.
2 On the Drawing toolbar, click Draw, click Change AutoShape, and then click the AutoShape you want.





Add or edit a special text effect
You can add a special effect to text by using the WordArt tool on the Drawing toolbar. You can create 
shadowed, skewed, rotated, and stretched text, as well as text that has been fitted to predefined shapes. 
Because a special text effect is a drawing object, you can also use tools on the Drawing toolbar to change the 
effect ¾ for example, to fill a text effect with a picture.

Keep in mind that a special text effect is a drawing object and isn't treated as text. You won't be able to format or 
edit the text in the text effect as you would text that's attached to an AutoShape or text in a text box.

What do you want to do?

            Add a special text effect  
            Change the text in a special text effect  
            Edit a special text effect  



Add a special text effect

1 On the Drawing toolbar, click WordArt    .
2 Click the special effect you want, and then click OK.
3 In the Edit WordArt Text dialog box, type the text you want to format, and then click OK.
4 To add or change effects to the text, use the tools on the WordArt and Drawing toolbars.



Change the text in a special text effect
1 Double-click the WordArt special effect you want to change.
2 Edit the text, make any other changes you want, and then click OK.



Edit a special text effect
1 Select the WordArt special effect you want to edit.
2 On the WordArt toolbar, select the options you want.

For Help on an option, press SHIFT+F1, and then click the option.





Enter the font you want for the text effect. The font applies to the entire text effect — you can't use two different 
fonts in the same text effect.



Enter the font size you want for the text effect. The size applies to the entire text effect — you can't use two 
different font sizes in the same text effect.



Applies bold character formatting to the entire text effect.



Applies italic character formatting to the entire text effect.



Enter the text you want to include in the text effect. You can type the text you want or paste it from the Clipboard 
(CTRL+V).








